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FCC Compliance

Copyright © 2013 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied
solely to assist authorized users of Eden260V 3D printing systems. No part of this document may be
used for other purposes, and it may not be disclosed to other parties.

The specifications on which this document is based are subject to change without notice.

No part of this book may be reproduced in any form or by any means, nor stored in a database or
retrieval system, without prior permission in writing from Stratasys Ltd.

If this document is distributed as a PDF file, you may print it for internal use.

The following are registered trademarks of Stratasys Ltd.: Stratasys®, Objet®, FullCure®.

The following are trademarks of Stratasys Ltd.: Eden, Eden500V, Eden350V, Eden350, Eden330,
Eden260, Eden260V, Eden250, Connex, Connex500, Connex350, Objet30, Objet30-Pro, Objet30-
OrthoDesk, Objet30-Scholar, Objet24, Alaris, Alaris30, Poly]Jet, PolyJet Matrix, CADMatrix, PolyLog,
Objet Studio, Job Manager, SHR, Clear, Durus, DurusWhite, MED610, MED690, ObjetGreen,
RoseClear, TangoBlack, TangoBlackPlus, TangoGray, TangoPlus, VeroBlue, VeroGray, VeroWhite,
VeroWhitePlus, VeroBlack.

Microsoft and Microsoft XP are trademarks of Microsoft Corporation.

All names of products and services cited in this book are trademarks or registered trademarks of their
respective companies.

The equipment referred to in this guide has been tested and found to comply with the limits for a
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. Objet 3D
printing systems generate, use and can radiate radio-frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference, in which case
the user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-RFID.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification
to this equipment. Such modification could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it
must be sent to appropriate facilities for recovery and recycling. For information about proper
disposal, check your purchase contract, or contact the supplier of the equipment.

Limitation of Liability
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The product, software or services are being provided on an “as is” and “as available” basis. Except as
may be stated specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any
kind, whether express or implied, including, but not limited to, any implied warranties of
merchantability, fitness for a particular purpose and non-infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental,
special, consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Stratasys has been advised of the possibility of
such damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of
procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software
or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product,
software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they
are based are subject to change. Stratasys Ltd. may, at any time and without notice, make changes to
this document. Stratasys Ltd., for itself and on behalf of its subsidiaries, assumes no liability for
technical or editorial errors or omissions made herein, and shall not be liable for incidental,
consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration
of data, delays, or lost profits or savings arising from the use of this document.
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About This Guide

Using This Guide

This user guide provides instructions for installing, operating and
maintaining Eden 3-D printing systems. It explains how to use features,
and provides practical examples to guide you as you use the system.

The text and figures in this guide are based on the Eden260V 3-D printer,
printer software version 27.3 and Objet Studio software version 9.0.10.

This guide assumes that:

® all the hardware, software, and network components of your Eden
system are installed, configured, and operating correctly.

® the operator has a working knowledge of the Windows® PC platform.

For More Information

1-2

Visit http://www.stratasys.com/ for more details about Stratasys technology,
products and consumables, and for service and support contacts.

For other documents that relate to Eden260V 3-D printing systems, and for
this document in other languages, contact your regional Stratasys Customer
Support office.

If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to c-support@stratasys.com.

DOC-32011 Rev. A
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Terms Used in This Guide

build tray

cleaning fluid

client/user workstation

Eden™ printer

Printer computer

Printer interface

Printer software

host/server workstation

Job Manager™

Model material

Objet Studio™

OBJTF (Objet Tray Format)

OBJZF (Objet Z Format)

resin

DOC-32011 Rev. A

In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing model feed tubes and the printing
block, used to completely remove model material from the
system before loading another type of material in the printer.
The cleaning fluid is supplied in model-material cartridges.

The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

The Objet 3-D printer referred to in this guide.

The computer inside the Eden printer that operates it. (This is
sometimes referred to as the “embedded” computer.)

The GUI (graphical user interface) used for controlling the
Eden printer.

Software running on the computer inside the Eden printer,
that controls all printer operations.

The workstation that interfaces directly with the Eden printer
and is typically positioned next to it.

The part of Objet Studio software that manages production
jobs before they are sent to the Eden printer.

Material used for building models.

The software with which users prepare jobs for producing
models.

The extension of a file that contains all of the information
needed for a model-printing job on Objet 3-D printers. An
objtf file is used to send a print job to an Objet 3-D printer.

The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzf files,
a printing job can be saved as a single file, for convenient
storage and transfer.

The base substance from which photopolymer printing
materials are made for use in Eden printers. In Objet Studio
and printer-application screens, “resin” refers to cartridges of
model and support materials.
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SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3-4.)

STL A file type used with Objet software. (For more information,
see page 3-4.)

Support material Material used for supporting the structure of models during
production.

1-4 DOC-32011 Rev. A
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Safety

Safety Features

Eden 3-D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Cover interlock The power supplied to the UV lamp, the tray
switch heater and the motion motors is turned off
when the cover is opened.

WARNING: Do not defeat (override) the
& interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

Cover lock The cover is locked while the printer is
working. It is released when the printer reverts
to pause or stop mode.

WARNING: Do not defeat (override) the
& safety lock. Doing so could result in serious

personal injury.

If the safety lock does not function correctly, do

not use the printer, and contact your service

provider.

UV screen The transparent section of the cover blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

Circuit breaker The power to the printer is turned off in case of
electrical overcurrent.
Note: The circuit breaker is only accessible to
service personnel.

Grounded chassis  The chassis of the printer is grounded, to
prevent electrical shock.
Note: The power outlet must be properly
grounded, in accordance with the local
electric code, to provide this protection.

If the Eden 3-D printing system is not used as specified in this guide, the
safety features may not provide adequate protection.

2-2 DOC-32011 Rev. A
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Symbols and Warning Labels

This following table lists the warning labels located on or in Eden printers.

DOC-32011 Rev. A

Warning Meaning Location Comments

Symbol
Hazard On the name plate | Read the instructions
(general) on the back of the | in this document

printer.

before operating the
printer.

Hot surface

On the print-head
block.

Risk of burns. Do not
touch this surface
after printing.

High voltage | Near the UV lamp | Risk of electric shock.
connectors.
Near the power-
supply enclosures.
Ultraviolet Near the UV lamps. | Risk of injury from
radiation ultraviolet radiation.
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Safety Guidelines

Printer

Installation

Printer

Operation

UV Radiation

Printer

Maintenance

3

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the Eden system. If the system is not operated as specified,
the user's safety may be compromised!

» Installation and removal of the printer should only be done by qualified
service personnel.

» Connect the printer to the electric outlet using a power cord that is
safety-certified.

A\

The electric outlet should be easily accessible, near the printer.

» Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.

» Leave a minimum of 15 centimeters between ventilation openings and
walls or other objects.

» The printer should only be operated by persons trained by a Stratasys
customer-support representative.

» All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment!

A\

Keep fingers and other body parts clear of the printer cover when
closing it.

Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!

If the interlock safety switch ever fails, do not use the printer.

V V V V

Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamps and the print block.
The UV lamps used in the printer emit dangerous radiation.

» If the UV lamps remain on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

» Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.

> Notify co-workers and those who have access to the Eden system before
beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

DOC-32011 Rev. A
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Model and
Support
Materials

DOC-32011 Rev. A

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Eden system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing-material
cartridge used.

> Store cartridges of model and support materials indoors, in a dry area
with adequate ventilation, between 16-27 degrees Celsius (60-81
degrees Fahrenheit). Never expose them to flames, heat, sparks, or
direct sunlight.

» Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.

» Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.

» When handling UV-cured models that may not be completely cured on
the surface, common latex gloves are adequate.

» To prevent respiratory irritation, ventilate areas where model and
support materials are used. The ventilation system should totally
replace the air at least 20 times per hour.

» Clean up model-material and support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.

» Do not wash contaminated clothing at home; clothing should be
professionally laundered.

» Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re-expose the user when these items are worn.
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First Aid for Working with Printing Materials

Contact with
Skin

Contact with
Eyes

Ingestion

Inhalation

2-6

In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first-aid instructions.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

» Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

» Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

» Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

» Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

The wearing of contact lenses when handling liquid printing materials is
not recommended. If the liquid splashes into the eyes when contact lenses
are worn, immediately remove the lenses and flush the eyes with water.

» Clean and disinfect the contaminated lenses.
» Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

> If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the patient warm but not hot.

Never feed anything by mouth to an unconscious person.

YV V V V

Oxygen should be administered by authorized personnel only.

DOC-32011 Rev. A
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Waste Disposal

Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste.

DOC-32011 Rev. A

>

>

>

A\

When removing the waste container from the Eden printer, wear
neoprene or nitrile gloves.

To prevent liquid waste from splashing into the eyes, wear safety
goggles.

Liquid waste from the Eden printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

Empty model-material and support-material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.

Do not attempt to reuse empty cartridges, and do not puncture them.

Dispose of used cartridges and waste containers in accordance with
local regulations.

Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

2-7
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Introducing the Eden 3-D Printing System

Figure 3-1: The Eden260V 3-D Printer

Work Configurations

3-2

The Eden 3-D printing system can be set up as a single-station system or as
a multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3-D printer, acts as a job
manager that sends production jobs to the printer for production.

Figure 3-2 shows the Eden260V printer set up in a multi-client
configuration.
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Client
workstations

Printer server

Printer
workstation

Printer

Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a
client station or as a master station (server or standalone station).

The Objet software arranges the jobs it receives according to their priorities,
model-material type, and other factors. In multi-workstation
configurations, the operator of the server —typically the production
administrator —has total control over the jobs sent to the 3-D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.
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Source Files

STL Files

SLC Files

Objet 3-D printing systems produce three-dimensional models designed
with most 3-D CAD tools and with other job-specific 3-D applications.
Eden systems accept:

e STL Files
¢ SLC Files

Eden systems feature the capability of producing both types of model files
simultaneously.

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.

For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The result is that high-quality object descriptions mean very heavy
files.

Most CAD software can export STL files. The Eden system utilizes these
files for building models (rapid prototyping), and also for directly making
molds for mass-producing items.

STL files are ASCII (text) files. The content of each file begins with “solid”
and ends with “end-solid” (both lower case). Between these keywords is a
list of the triangles that describes the faces of the solid model. Each triangle
defines a single normal vector directed away from the solid’s surface,
followed by its X-Y-Z coordinates. These are expressed as Cartesian
coordinates and are floating-point values. The coordinates of all triangles
should be positive and should fall within the volume of the model.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid-object images displayed from
STL files.

Printing Materials

Eden printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:

* Model material —which makes up the finished model

* Support material —which fills gaps and spaces in the model during
printing, and is removed after printing
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Materials used for printing models with Eden printers are made of resins,
which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
printing materials.

* When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

* Store material cartridges indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
If exposed to heat or flames, cartridges may burst or ignite.

* Signs of premature polymerization in material cartridges may include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

* Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:
* Do not expose to flames, heat or sparks.

* Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

* Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

You can find more safety information about resins in “Safety Guidelines” on
page 2-4, and “First Aid for Working with Printing Materials” on page 2-6.

Dispose of cartridges of Objet model and support material in accordance
with all applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.
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Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the Eden 3-D printer. Therefore, it is recommended that you use ventilation
or air-conditioning systems, if necessary, to keep the work area within the
following ranges:

* 18°-25° C (64°-77°F)
* 30%-70% relative humidity
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Workstation Requirements

The minimum requirements for computer components used with Objet 3-D
printer software are listed in the following table.

DOC-32011 Rev. A

Server/
Stand-alone Station

Client Workstation

Processor

Pentium 4, 3.0 GHz, 512 KB cache memory (min.)

Operating System*

Windows XP Professional SP2

Graphics Card Supporting open GL, with 512 MB of memory
For dental printers, use:
¢ ATI Radeon HD 5970, with 2 GB of memory
or
* NVIDIA GeForce GTX 285, with 2 GB of memory
RAM 4 GB (min.)
CD Drive IDE CD ROM
Hard-Disk Drive 40 GB (min.)
Network Adaptor | LAN TCP/IP (2) LAN TCP/IP (1)
Cards

Ethernet Cables

e Straight-through cable (1)
*Crossover cable (1, supplied)

Straight-through cable (1)

* Also supported:

O Windows 7 (32-bit/64-bit), Professional, Ultimate, Enterprise editions
0 Windows Vista (32-bit/64-bit) Ultimate, Business, Enterprise editions
Note: On 64-bit operating systems, Objet Studio runs as a 32-bit

application.

Recommendations:

* Monitor resolution: 1280 x 1024 pixels
* Color quality: 32 bit
* Two Ethernet ports
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Preparing Files for Use with Objet 3-D Printing Systems

Converting
CAD Files to
STL Format

Converting
Files to SLC
Format

Before using files with Eden 3-D printing systems, you must convert them
in your CAD program to either STL files or SLC files. (For an explanation of
these file formats, see “Source Files” on page 3-4.)

After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics, by Materialise) before
opening them in Objet Studio and producing the model.

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.

2. In the Save As dialog box, open the Save As Type pull-down menu and
select *.STL.

3. Click Options and set the following parameters:

* Total Quality —approximately 0.1 mm (deviation tolerance / linear-
dimension tolerance)

* Detail Quality —approximately 4° (angle tolerance)

Note: Lowering these values produces more accurate models, but
results in larger files and longer loading and processing times. For this
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5-19.
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Objet Studio software for the Eden 3-D printing system consists of two
main screens:

* Tray Settings / Model Settings
* Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Eden 3-D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic
procedure:

Inserting one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

Ll

Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Eden 3-D printer for production

Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Eden 3-D printer.

* In Objet Studio installed on the directly-connected computer (server),
the Job Manager screen displays the queue and status for all jobs sent to
the 3-D printer by the client computers on the network, and allows
editing and manipulation of all jobs.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to the 3-D printer server
from that computer, and allows the user to edit only these jobs.

Client computers can be connected, via the local network, to different Objet
3-D printers, but only to one at a time. The Job Manager screen displays
the status of the 3-D printer to which the client is currently connected.
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How to Install Software for the Eden 3-D Printing System

The Objet Studio setup wizard guides you when installing the Objet
software. During installation, you must choose to install either the server
(“host”) application or the client application.

To install Objet software:

1.
2.

3.

Insert the Objet Studio CD into the disk drive.

Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).

Open the CD-drive folder and select Setup.

To run the installation wizard, you must accept the Objet Studio license
agreement. After reading its terms, click Yes to continue, or No to close
the wizard.

If you click Yes, the following screen should appear.

i Objet Studio 9

Welcome to the Objet Studio 9 Setup Wizard

The inztaller will guide you through the steps required to install Objet Studio 9 on your
computer,

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

[ Cancel ] [ < Back ] [ Mewt > l

Figure 4-1:0Objet Studio installation wizard—Welcome screen

Click Next to begin installation.

In the Select Features screen, select the required installation option.
Select Objet Studio for a server computer...

® if you are installing Objet Studio on a server (“host”) computer —
the computer directly connected to an Eden printer.

¢ if you are installing Objet Studio on a standalone (off-line)
computer.

DOC-32011 Rev. A



Eden260V User Guide

DOC-32011 Rev. A

6.

It is recommended that you do not change the default destination folder.

Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation —a remote computer that prepares

print jobs and then sends them to a server computer.

i Objet Studio

Select Features

Select the prefered Objet Studio Installation twpe for your computer

(%) Obiet Studio for a server computer.

() Obiet Studio for client workstations.

[ Cancel ] [ < Back ] [ Mewt >

Figure 4-2: Objet Studio configuration selection

In the Select Installation Folder screen, verify the destination folder and

click Next.

i Objet Studio 9

Select Installation Folder

The inztaller will install Objet Studio to the following folder.

Ta inztall in this folder, click "Mext. Toinstall to a different folder. enter it below or click “Browse.

Folder:

C:\Program FilestObjetStudio’ Browse...

Inztall Objet Studio 9.0.10.7 for vourself, or for anyone who uses this computer:

Figure 4-3: Objet Studio installation-folder selection

In the Confirm Installation screen, click Next to begin installation.
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8.

In the Select Printer Type screen, select the Objet 3-D printer used for

producing models.
To continue, click Next.

i Objet Studio 9

Select Printer Type

Select an Objet Printer.

() Objet24
() Obijet30
O Connex260
(O Connex3s0
(%) Connex500
() Eden 250
() Eden 260
() Eden 3500
() Eden 500

[ Cancel ] [

< Back

J {

Mext >

Figure 4-4: Printer selection

Installation begins and a progress bar appears, showing the progress of

the installation process.

i Objet Studio 9

Installing Objet Studio

Obijet Studio 9 iz being installed.

Flease wait...

Cancel

Figure 4-5: Installation progress bar
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When the Objet program installation is complete, the final InstallShield
Wizard screen appears.

i Objet Studio 9

Installation Complete

Obijet Studio 9haz been successfully installed.

Click "Close" to exit.

Cloze

Figure 4-6: Final installation screen

Sometimes, you must restart the computer to complete the software
installation. You can do so now or at another time.

Note: Make sure to remove the CD from the disk drive before restarting the
computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:

® Objet Studio

® Stop Job Manager (for servers and standalone stations)
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After you install Objet Studio, a launch icon Oh]i‘tﬁdin appears on the
Windows desktop. Open the application by double-clicking this icon, or by

selecting Objet Studio from the Start menu.

Objet Studio opens, displaying an empty build tray.

/‘.‘ T — ||+
: s cBe O I @ @ W emrw
Objet = b s e \Standard
Studio . : e -l S |~ Toolbar
Commands /...
menu G
Active
Quick ribbon
Access
toolbar
Model tree
pane Job
Manager
tab

Figure 5-1: Objet Studio opening screen

The Objet Studio interface consists of two main screens:

* Tray Settings—for arranging models and preparing them for printing.
This screen is described below.

* Job Manager—for monitoring and managing print jobs.

This screen is described in “Monitoring and Managing Print Jobs” on
page 57.

Each is controlled by menus and icons on its own ribbon. An additional
ribbon, Model Settings, displays controls for configuring and manipulating
selected models.

Objet Studio anticipates your work flow by displaying and enabling the
options relevant to your current task. For example, when you first open
Objet Studio, the Model Settings ribbon is disabled until you place a model
on the build tray. Similarly, menu options available from the Standard
Toolbar menus are enabled or disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in
“Customizing Objet Studio” on page 45.

Instructions for using the commands for preparing models for production
and sending jobs to the printer, appear later in this chapter.

Qtﬁ»

Tray Settings

0 iz

Insert || placem

Job Manager

s o

Hew Open Save | Undo Reds

e Buid) Plane

Single

e~

Model

Build Process

Selection File Edit
Figure 5-2: Tray Settings ribbon

= ObjetStu... Wrench Key

"
=4 Tray Settings

go Cut %S Val _‘EJ

Model Settings Job Manager

B @& @ Q

9000 Delete Undo Redo | Flane || Move Transform Lock || Single Zoom
Bacta View Tray~
Edit Selection Manipulate Wigwt

Figure 5-3: Model Settings ribbon
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- = x
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7 1020 Material =
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Ribbon The following table lists the Tray Settings and Model Settings ribbon
Commands command groups, and shows when they are enabled, and where they
appear.
Group Purpose When Tray Model
enabled Settings  Settings
Ribbon  Ribbon
Setting display | Always.
g%% colors.
= v |
Material =
Colars
ﬂ OL Selecting Models are on
erspective and | the build tray.
Single: Zoom EOOIE level. Y d d
Wigy = Tray =
Yiew
| Choose to select | Models are on
Plat:e a plane. the build tray. d d
Selection
) Change the Models are on
Tsometric perspective of | the build tray. d d
o the active pane.
{@E@
=157
‘5‘1@
e
.. b={
VIHO [ Hs Assigningmodel | ¢ Build tray
Fulicure720 - material. is empty. d
Currently Loaded: FullCure7za * Models are
not
selected.
Val Undoing or After an
ek redoing actions. | action or d
o oinect
= selection.
Edit
veroiithite: 4.0 Estimating the | Build tray is
Suppork: 29.0 an}‘)‘%nt o empty d
BudraTine: |12 printing Models are
HiEna e = materials not selected.
Estimated Consumptions required.

= Mew

.\.} Open

Hf Save
File

Opening and
saving tiles.

Models are
not selected.
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5-6

5

files on the build

Group Purpose When Tray Model
enabled Settings Settings
Ribbon  Ribbon
Placing model | Always.

J

Insert tray.
Madel
» % - &’ Pre-build/build | Models are on
w ¥ON commands. the build tray. d
Placement ‘alidate Estimate Build
" o Scalay Setting model | A model is
1416 dimensions. selected. d
201,01
Dimensions {rmm)
4 Cut %_\ e Cutting, A model is
B CoPY  Dote Undo Redo copymig, pasting | selected. d
e e = - and deleting
= models.
Edit
T @ 41 Moving, rotating | A model is
= b B and resizing selected. d
Move Transform  Lock models.
Manipulate
DD Assigningmodel | A model is
4 finish an selected. d
atte |Glossy Advanced N
setting support
strength/
etz “hollow.”
g Setting amodel’s | A model is
T unit of measure | selected. d
o (millimeters or
. inches).
Uniks

tooltip. The “Undo” and “Redo” tooltips change to reflect your last Objet

% To quickly identify an icon, move the cursor over the icon to display its

Studio action.
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Objet Studio
Commands
Menu

Model Tree
Pane
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Clicking the Objet icon @) (in the upper-left corner) opens the Objet
Studio Commands menu. This menu displays basic application commands
and options.

Ve LA EESL

\?g/' Hew Recent trays
> 1 testiengn
= Qpen,..
2 Trayad
é Save

3 Ci\Program Filesy.. \Trayss

é Save As
h e 4 C:\Program Filesy.. .| Trayl
n@ Save Bitmap. .. Ctr+B
@. Imj
Import Packed Job. ..
@ Export Packed Job. ..
.@;‘ Build Properties. ..
“ij User Preferences. ..

ri Printer Properties...

Restart

Figure 5-4: Objet Studio Commands menu

The Options button opens a dialog box for customizing Objet Studio.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]

O Mever

(@) Ahways

(O \When under the tray
Large Filez

() Load Ful

(O Load Partial (reduced)

Load Search Order
O Local

(®) Original

[ Ok H Cancel ]

Figure 5-5: Options dialog box

The Model Tree pane lists the objects placed on the build tray. By default,
the pane “floats” — that is, you can move it to another position on the
screen and resize it. Alternatively, you can fix its position at the left of the
application window, and even hide it.
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Preparing Models for Production

OBJDF Files:
Overview

Model Files

Placing
Objects on the
Build Tray

Model preparation involves the following basic steps:

1. Place objects on the build tray.

2. If necessary, manipulate the object’s orientation and position.

3. Select the material and model finish.

An objdf file describes both the geometry of a single object and the material,
and finish required to print it. You can use the objdf format to save a group

of separate objects on the build tray as one unit, together with their relative
positions and material.

Further explanations of objdf files, and instructions for utilizing their
features, appear throughout this chapter.

To produce models, you must open one or more model files in Objet Studio
and position objects on the build tray. You can place objects on the build
tray in two ways:

* by inserting individual stl or sic files.
* Dby pasting objects that you copied to the Windows clipboard.

If you know what type of model material will be used to produce the
models, make sure it is selected from the material drop-down menu.

FullZure?z0 -

[ ] Fullcurezzo
B =roblack

Figure 5-6: Model material selection toolbar

Note: It is not necessary to select the model material now, but it is
recommended—each type of material has unique characteristics
that may affect the valid positioning of objects on the build tray.

To place an object on the build tray using stl, slc or objdf files:

Open the Insert dialog box—

* From the Object menu, select Insert.
or—

* On the Tray Settings ribbon, click nsert .
or—

* Right-click on the build tray, and select Insert from the context
menu.
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The Insert dialog box appears.

Look in: | (=3 Samples - + ¥ = E3-
5 (_JBasic Shapes
) ) Chess
My Recent | Connex Samples
Documents | Connex_Samples
f = _JEden_alsris_Samples
| ‘;j Cilmages
Desklop LDSLE Fles
_JSTL Fles
i Text30
L Trayl
My Documents
)
wd
Iy Compuber
- File name: sample file bt
My Metwork  Files of bppe: STL Fiies [“.5t) v | Cancel
Units: Militater bt
Number of Copiez: |1 > D [#] Diert Automaticale
Coordnales
Width (] Depth(Y] Hexght )
Etents 229 5o2ae 229
[¥] Prenview

Figure 5-7: Insert dialog box

In the Look in field, display the appropriate folder.
In the Files of type field, select the file types to display (stl, slc, objdf).

Select the desired file, and make sure that it appears in the File name

field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in figure 5-7.

The Model Settings ribbon is displayed when objects are placed on the
build tray.

Note:

Select any of the following options, as required:

Units — Millimeters or inches for the object’s units of measure.

The 3-D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 23.

Number of copies—How many copies of this object to place on the
build tray.

Orient Automatically — Automatically orient objects on the build tray
for efficient model building.

The Extents values displayed in the Insert dialog box’s Coordinates
field, represent the maximum dimensions of the object on each axis.
These dimensions correspond to the virtual “bounding box”
surrounding the object see figure 5-49 on page 36).
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6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

I@.‘hﬂh Sl Pt i poler Obiet Shdin: EOEN

Tray Gettingz: P Settinges Enee i - Wew
Model o My 00y Wy W @ 0o [ unaom oot | [~ mm '_]_Ilﬂ o
Tree DO e U e (| P || e Teeten oo VRO Wte sy e
pane \ Puta ® o mae 7

£ sebection Hanadsts Caverans dus] Lnds Opiies
=~ BT
| Pocket CordHoldes

Model
Toolbar _|

Figure 5-8: Default screen layout

The Model Settings ribbon is displayed when objects are placed on the
build tray.

If the object is over a certain size, the Loading Placed Elements dialog box
may appear.

Loading Placed Elements

todel Mame IE:"-...."-.GHender"-.B in%Trayl obitf

[ ]
Plac:ed Elerment II::"'...."-.testI:uuiId.DI:uidf
| ]

Figure 5-9: Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 33).
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Opening objdf files Before placing objdf files on the build tray, Objet Studio must extract the
component sfl files together with information about their orientation and
materials. To do this, Objet Studio creates a folder with the same name as
the objdf file, in the same location.

Look in: | I Samples

@.

My Recent
Documents

=

Desklop

2>

My Documents

My Computer

by Metwork,

|C5)Basic Shapes
() chess

|C5) Connesx Samples
|C5) Connes_Samples
[C)Eden_alaris_Samples
@Images
I5)sample File
[C)5LC Files

[C3)5TL Files

(5 TextaD
@Trayl

ray |

File name: |Tray1

v

[ Inzert ]

Filez of type: | Obijet Digital Files [* objdf]

]

[ Cancel ]

Urits: Millitd eter v
Number of Copies: |1 £

Coordinates

Width (] Depth [v)  Height [£)
Extents

I aterials

Packed Azzembly File
Wercwhite

- [ Orient Autornaticaly

Preview

Figure 5-10: Insert dialog box (objdf file)

DOC-32011 Rev. A

5-11



Using Objet Studio

Opening Objet
Tray Files

5-12

You can open trays that were saved as objtf files, for example, a tray you
saved while preparing it for printing, and now you want to continue
preparing it.

To place an object saved as an Objet Tray File (objtf) file on the build
tray:

1.

From the File group, click open.

or—

From the Objet Studio Commands, select Open.
The Open dialog box is displayed.

Bk
Look in' [ 3 Basic Shapes v o2 @
y Einew
9 (a1 |
My Recent
Documents
=
Deskiop
My Documents
3
8
My Computer
‘,‘] File rame: Tray1
2
My Network  Files of type Obiet Tray Files (%.obitf) -
Coordinates
[#] Pravisw

Figure 5-11: Objet Tray File Open dialog box

Select the desired file, and make sure that it appears in the File name
field.

If the Preview check box is selected, the object is displayed.
Click Open.
Objet Studio opens the tray file.
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Stl file loading
preference
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If there are identically named st/ files in more than one location, you need
to ensure that the correct component st/ files are linked to the objtf file. For
example, if there are identically named st/ files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you
can set the default location from which files are loaded.

To set the Load Order:

1.

From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
In the Options dialog box, display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]
O Mever

(@) Ahways
(O \When under the tray

Large Filez

() Load Ful
(O Load Partial [feducad

oad Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-12: Options dialog box, Settings tab

Under Load Search Order, select an option:

* Local—to load files from the location where they were last saved.
* Original—to load files in their original location.

Click OK.
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Quick-Access
Model
Commands

Model Toolbar

Right-click model
menu

S

5-14

You can access common commands for working with objects on the build
tray with the convenient Model Toolbar and context menus.

Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Figure 5-13: Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description

Applies a matte finish to the model.

Applies a glossy finish to the model.

Opens the Advanced Properties dialog box for setting the
Grid Style and the Hollow option.

A Enables dragging an object (see page 24).

Opens the Transform dialog box for changing the
object’s position and scale.

= Toggles the Lock Model Orientation setting.

If you right-click on an object, a pop-up context menu is displayed from
which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See “Building a Quick Access Toolbar” on page 89.
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Copying and
Pasting
Objects
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If you need to duplicate objects on the build tray, you can, of course, insert
the same object from its file more than once. An easier way, however, is to
copy and paste the object. You can copy objects from the build tray or the
model tree. The objects copied remain in the Windows clipboard until you
paste them onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. Copying and pasting also allows you to utilize objects
already configured on previously-used build trays for newer projects.

You perform the Copy and Paste commands as in other Windows
applications:

* from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them
on selected axes.

Paste Special E|
Mumber of Copies E
Delta
= 100 Y 100 Z |0 rirm
M anipulate
Mirrar [ I [N =
Flip [ ES 1y [z
[ ]5ave as Defaults [ ] l [ Cancel

Figure 5-14: Paste Special dialog box
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Selecting
Objects

Surface Finish

5-16

To manipulate an object on the build tray or assign characteristics to it
(building style, for example), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is
highlighted in the model tree. You can select multiple objects by drawing a
box around them with the mouse cursor, or by pressing the Ctrl or Shift keys
while clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

* Select All
* |nvert Selection
* Undo Select object

Edit = Wjew + Ohject -

4 undo Select object

Select All
Invert Selection
Figure 5-15: Edit menu
Models can be printed with a matte or glossy surface finish. To create a

matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:

1. Select the model.

2. Select Matte @ or Glossy @ in one of the following places:
*  Model Settings ribbon, Options group
* Model Toolbar
* right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects” surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 32.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated logically for your needs, according to the
considerations explained in “Model Orientation” on page 19.

Automatic
Orientation

S

DOC-32011 Rev. A

Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum

orientation and position, or you can control them.

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

Look ir:

A
16)
My Recent
Documents

Desktop

My Documents

w8
My Compiter
<

-
My Network

7 x|
3 Samples ¥ O3 =
8asic shapes
chess
£ Cornex: Samples
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CEden_aris_Samples
Clmsges
Csample il
C)5LC Files
(E)STL Files
D Text3D
ZTrayl
B Trayt
Fils name Trayt v Inser
Files of pe: | Obiet Digital Files ["cbi)
Urits [ ister v

Nurber of Copies : |1 2 €O orient Automaticaly

Coordinates
Height 2] i

Width <) Depth[v]
Extents
Preview

Mateials
Facked fssembly File
Verowhits

Figure 5-16: Orient Automatically option disabled

You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see “Default Settings” on

page 51.
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Automatic After placing several objects on the build tray, you can let Objet Studio

Placement arrange them on the tray for printing. This ensures that the objects are
positioned properly, and that they will be printed in the shortest time and
with a minimum of material.

To automatically arrange objects on the build tray:

» On the Tray Settings ribbon, click Placement .
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-18: Tray arrangement when applying automatic placement

Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

* The physical characteristics of each type of model material you use can
affect the positioning of objects on the build tray. Therefore, select the
material before running Automatic Placement.

%( * For best results arrange the tray with Automatic Placement, on the Tray

Manual You can change the position of objects on the build tray —even if they were

Positioning inserted with the Orient Automatically option. Considerations for
positioning objects are presented in “Model Orientation,” below. Tools for
changing the position of objects are presented in “Manipulating Objects on
the Build Tray” on page 20.

5-18 DOC-32011 Rev. A



Eden260V User Guide

Model Orientation
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The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3-D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along
the Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

» Any surfaces that come into contact with support materials become
matte.

» Since high-resolution models are built up, on the Z-axis, in 16 or
30-micron layers (according to the selected printing setting), it is very
time-consuming to print a tall object. From this point of view, it is
advisable to place the object's smallest dimension along the Z-axis.

» Since the print heads measure about 2 inches (5 centimeters) on the Y-
axis, models measuring less than this (on the Y-axis) are printed in one
pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

» Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that support material is not
required on the top of the printed model.

Recess-Up Rule

This rule considers models containing surface recesses.

» Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

» The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
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Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

» It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.

Manipulating Objects on the Build Tray

Positioning
Objects on the

Z-Axis

5-20

S

When you use the automatic positioning option to arrange objects on the
build tray (see “Automatic Orientation” on page 17), the objects are
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

In practice, the Eden system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

To position objects directly on the tray:

1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement
Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

prertmatic Lay On [Gravity
O Mever

(@) Ahways
() \When under the tray

Large Filez

() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local

(®) Original

[ Ok H Cancel ]

Figure 5-19: Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

* When under the tray—The display of objects that are below the build
tray is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is
not changed.

DOC-32011 Rev. A



Eden260V User Guide

Valid Object
Placement

3
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You can ensure that models do not overlap when you position them on the
build tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. From the Tools menu, select Constraints Settings.

| a‘
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-20: Constraints Settings dialog box
2. Select Dynamic check to identify:
* invalid object placement while placing objects —On Drop selected.
* invalid object placement after moving objects —While Drag selected.
* objects placed beyond the tray’s boundaries —Outside Tray selected.
* objects that overlap—Object Collision selected.
Even if you do not use Dynamic Check when placing objects on the build
tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can

also manually check for problems after positioning objects (see “Tray
Validation” on page 36).

Note: Remember that Objet Studio calculates the space occupied by an
object including the “bounding box” surrounding it (see figure 5-33
on page 29).
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Usinga Gridto Displaying a grid on the image of the build tray can be useful when

Position positioning objects. You can make use of this feature by selecting the
Objects following menu options.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid | When moving the object, it aligns with the nearest

grid line.
Tools > Options > Enables you to change the grid origin
Grid (X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them —from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options §|

Appearance | Grd Manipulate | Display | Settings
[ Display arid
[15napto grid
Colors

Tile zize 20 | mm

= Base -
Maiar divisi 10 = i

ajor division v | tiles Bt -

Mumber of tiles |32 E

= Majar -
Line style Dot
Uritz Millitd eter v
Oigin [0 3o 2o < |mm

u].9 Cancel

Figure 5-21: Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement
Units
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3-D files contain an object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
> In the Insert dialog box, Units field, select Millimeter or Inch:

Insert

Look in: | I Samples v | Q ¥ m-
Y |C5)Basic Shapes
4 23 () chess
My Recent |C5) Connesx Samples
Documents |23 Connex_samples
— [C)Eden_alaris_Samples
=
|_ CImages
Desktop I5)sample File
[C)5LC Files
: [CSTL Files
"‘/' [ Text3D
Trayl
My Documents Dotray y
@ sample file
My Computer
- File name: | & | [ Inzert ]
My Network | Files of type: 5 Hj
Millitd eter v

Figure 5-22: Units field in the Insert dialog box

To change units of measurement on the Model Settings ribbon:
1. Open the Units flyout toolbar.

mm
| o

Millirmeter

w

B

inch
| |

Figure 5-23: Units flyout toolbar
2. Select the measurement units desired.

To change units of measurement with the Standard Toolbar:
1. From the Object menu, select Change Units.

hillibd eter
Inch

Figure 5-24: Model Units dialog box
2. In the Model Units dialog box, change the setting and click OK.
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Setting Model
Dimensions

Repositioning
Objects

5-24

You can change the object’s dimensions by changing the coordinates in the
Dimensions group on the Model Settings ribbon.

i
i
£

l

54,65 ~3
34,80
10,00

Cimensions () ]

Figure 5-25: Dimensions on the Model Settings ribbon

Note: You can change the height of the objects on the build tray only if this

is allowed by the Objet Studio settings(see “Positioning Objects on
the Z-Axis” on page 20.)

You can manually move and rotate an object on the build tray with the
arrow keys, or by dragging it with the mouse.

To manually manipulate an object:

1.

Select an object by clicking it on the build tray, or in the model tree
pane.
Click move on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-26: Manually moving an object
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3. Ifyou click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-27: Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

Using the Transform  You can make precise changes to an object by changing the properties in the
Dialog Box  Transform dialog box.

To access the Transform dialog box (when an object is selected):
* Click ﬁ; on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

Transform rz|

idth(x) Depth(t] Height(Z)

. -
Translate.| 0 v|

-

u;|

|
Fotate: | [ | [
|

Scale: |‘I e 1 :|

Cancel Actions

Figure 5-28: Transform dialog box

To change an object with the Transform dialog box:

» Change any of the values, then click Apply to see how the object changes
on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
» Click Reset.
Note: The object does not change. Any changes previously applied remain.

To undo all changes made with the Transform dialog box:
» Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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Changing an There are several methods for changing the orientation of objects on the
Object’s build tray.
Orientation To rotate an object:
> Select the object and use the Object menu options (see also
“Repositioning Objects” on page 24).
To re-align an object’s plane: ?
1. On the Tray Settings or Model Settings ribbon, click e .
or—
From the Tools menu, select Plane Alignment > Select Plane.

2. Click on part of an object on the build tray.

The selected plane is displayed.

Alignment
toolbar

Selected
plane

Figure 5-29: Aligning by plane

3. On the Alignment toolbar, click an appropriate icon to change the
alignment.

or—

From the Tools menu, select Plane Alignment, and select an alignment

option.

| Plane Alignmenk k -E Select Plane

Professional Mode L'{' Align Battom
TirmeMaterial Estimation "} S iz
assembly Map ... i Align Front

%0 Align Back

LEEN=EfEn: S Align Left
Lptions. . o align Right

Figure 5-30: Tools menu, Plane Alignment options
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Freezing Model
Orientation
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To cancel plane selection after re-aligning objects on the build tray:

.z-li_.J
Flane
» On the Tray Settings or Model Settings ribbon, click e -
or—
From the Tools menu, select Plane Alignment > Select Plane.
To flip an object 180 degrees on any axis:
1. Select the object.

2. From the Object menu, select Flip > Flip X / Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:

1. Select the object.

2. Display the Transform dialog box (see figure 5-28 on page 25).

3. Change the Rotate parameters for each axis.

If you manipulate an object on the build tray, you can freeze its orientation

so that it does not change when you position it automatically (see
“Automatic Placement” on page 18).

To freeze an object:
1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click & .

To unfreeze an object:
> Select the object and click & (to de-select it).
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Display Options
Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid
(“shaded”) objects.

Figure 5-31: Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

» From the View menu, select WireFrame.

Figure 5-32: Tray and model displayed in WireFrame view

To revert to the shaded view:

» From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

» From the View menu, select Display Bounding Box.

i

Figure 5-33: Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

» From the View menu, select Display Thickening Box.

Figure 5-34: Model displayed with thickening box

To display the maximum build height:
» From the View menu, select Display Tray 3D Box.

Figure 5-35: Tray 3-D Box

To display objects without the build tray:
» From the View menu, clear (de-select) the Display Tray option.
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Screen Layout Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Wiga

Figure 5-36: Screen layout icons

3 Single View is the default screen layout.
O 4 Views displays perspective, top, front and right views.

Madel Trom
EL T
7 s cat e

h - RIGHT F

Figure 5-38: 4-view screen layout
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Tray
Perspective

Tray Positioning

DOC-32011 Rev. A

The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:

1. On the Tray Settings ribbon, open the Perspective flyout toolbar.
I=ometric

-

Figure 5-39: Perspective flyout toolbar
2. Click the icon that represents the desired perspective.

To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:

» Press the mouse wheel while moving the mouse.

] a1 [

Figure 5-40: Tray after moving it in the Objet Studio display
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Setting Object
Colors
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To manually rotate the tray:

> Press Alt and press the mouse wheel while moving the mouse.

9
P \
-

A0 62 EmL Mol | M

Figure 5-41: Tray after rotating it upside-down

The color of objects on the build tray can indicate how they are printed.
Objet Studio enables you to choose the color display so that you can easily
see the material, and surface of objects.

To choose how colors are applied on the display:

» On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

*

ke Color Indicates Model material

Makerial ~
@ﬁ/ Color Indicates Model surface
Lt _\_"v'

===

®

=

Figure 5-42: Colors display options

Before sending a build tray to the printer, or when you perform tray
validation, Objet Studio checks if there is a problem with the stl files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see “Tray Validation” on page 36).
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Loading Large  Very large st files can be slow to load and may be difficult to manipulate

Files easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The st! file itself
is not changed, and the complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Options x|

| tppearance | Grid | Manipulate | Display | Settings |

Automatic Flacement

Quick Automatic Placement after adding new object

Preserve mm  distance between objects

Automatic Lay On [Gravity)
O Never

(@) Abways

OWhen

Large Files

O Load Full
(&) Load Partial (reduced]

Laoad Search Order

© Local

Apply
Figure 5-43: Options dialog box, Settings tab

2. In the Large Files section, select Load Partial (reduced).

Large File If you need to work with a detailed model that is composed of a large

Manipulation number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed

models.

Figure 5-44: Object displayed without polygon reduction

Figure 5-45: Object displayed with only five percent of its polygons showing
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To use polygon reduction:

1.

From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.

In the Options dialog box, display the Display tab.
QOptions EI

Appearance | Grid Manipulate | Display | Settings
[[] Enable Polygon Reduction

Display while changing wiew
(%) Bounding Box

() Entire Object

Diigplay when static view

) Bounding Box
(®) Entire Object

Save Polygon Reduction Data

Figure 5-46: Options dialog box, Display tab

Select Enable Polygon Reduction.

Select Polygon Reduction (Percent).

Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being

moved).

Set display options when the object is being moved (Display while

changing view):

* Bounding Box— A box representing the object’s maximum
dimensions is displayed.

* Adaptive Polygon Reduction —Varying degrees of polygon reduction
are applied, as necessary.

* Entire Object—No polygon reduction is applied.

To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

Click Apply to see the results of the settings without closing the dialog
box.

Selecting the Entire Object options cancels polygon reduction.

The display format affects how quickly objects display. For example, if you
select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).
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Zoom Options

S
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To select the object display preference while changing view, and in static
view:
1. Select to display objects:
* With a Bounding Box (see figure 5-33 on page 29)
*  With Adaptive Polygon Reduction (changing view only)
*  With Polygon Reduction (static view only)
* Entire Object
2. Click OK when done.

While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

» On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom by Rectangle

Figure 5-47: Zoom flyout toolbar
O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.

O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See “Automatic Zoom” on page 51.
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Handling Completed Trays

After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3-D printer for production. But
before saving the tray, you can check that there would be no problem
producing it. You can also calculate how much material would be
consumed during production and how much time this would take.

Tray Validation Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

To validate that the tray can be printed: Y
» On the Tray Settings ribbon, in the Build Process group, click valdate .
or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

| @1
Constraints
Colars
Default Color

Outzide Tray

Callision

iin

Bath

Dynamic check
when to check

(® On Drop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-48: Color code

The validation status appears on the bar at the bottom of the screen.

Yalidation succeeded Maodels: 1

Figure 5-49: Validation details in status bar
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High Quality/  Objet Studio allows you to choose the quality/speed setting most suitable
Speed Setting  for your job.
HQ (High Quality)—
* Prints models in 16-micron layers, suitable for producing fine details
and delicate items.

* Requires much more time to print most trays, compared to High Speed
setting.

HS (High Speed)—

* Prints models in 30-micron layers, suitable for producing larger
models.

* Requires much less time to print most trays, compared to High Quality
setting.

Change the setting, if necessary, before sending the tray to the 3-D printer.

VI HQ [ HS
FullCure?z0 -

Currently Loaded: FullCure7z0

Figure 5-50: Quality/speed setting

Production Objet Studio enables you to calculate the time and material resources

Estimates needed for producing trays before sending them to the printer. The time it
takes Objet Studio to make this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current
tray: \.:..

» On the Tray Settings ribbon, in the Build Process group, click estimate .

While the estimate is being calculated, a progress bar is displayed —on
the right side of the status bar (at the bottom of the screen).

L

I ks ____Cancel

Figure 5-51: Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in the Estimated Consumptions group on the Tray

Settings ribbon.
Weroiihite: 3.0
Suppork: 27,0

Building Time:  00:23
Estimated Consumptions

Figure 5-52: Production resource calculation
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You can e-mail objif files using Microsoft® Office Outlook®.

To e-mail a file:

1.

2.

From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the e-
mail form.

Enter the e-mail address and send the file.

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the 3-D printer.

To send the tray to the print queue:

1.

On the Tray Settings ribbon, Build Process group, click .

If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 36), and the following warning message
appears.

Warning E|

Overlapping modelz cannot be printed.
Select Automatic Placement,

or zeparate the models manually,

and rezend this job.

Do you want bo proceed anpway’?

l Yes l I Mo l

Figure 5-53: Tray validation warning message

O To cancel the Build command so you can correct the problem, click
No.

O To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 57.
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Applying Additional Objet Studio Features

Dividing
Objects
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You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.

To split an object:

1.
2.
3.

Select the object.
From the Object menu, select Split.

In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

Model Tree

© Tray1
__| Applications - FLUTE_shell3_Partt
__| Applicationss - FLUTE_shell3_Partz

Obiject Size 35 226 225348

@splittpSice 97 |37 202 | [ Dateut
O Spit by Number |-  EN | |

Figure 5-54: Split Object dialog box
In Save to Folder, enter the folder name.
Click OK.

The composite parts are saved as new st! files with “Part 1,” “Part 2,”
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you

check them for defects in an STL-repair application, such as Magics,
by Materialise.
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Support
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When producing models, support material fills some hollow and empty
sections (see “Model Orientation” on page 19). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a
model:

1. Select a model on the tray.
2. On the Model Settings ribbon, in the Options group, click %.
or—
¢  On the Model Toolbar, click .
or—
* From the right-click context menu, select Advanced Properties.

The Advanced Properties dialog box opens.

Advanced Properties ﬁ

Grid Style [ ] Hallaws
{*) Standard

) Heawy
(7 Lite

Apply

Figure 5-55: Advanced Properties dialog box

3. In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.

* Standard—for models needing average support (most models).
* Heavy—for large models needing much support.
* Lite—for delicate models needing little support.

4. Click Apply.
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“Hollow"— Many objects placed on the tray from st! files are “solid.” This means that,

Filling Models  when printed, the model will be completely filled with model material.

with Support Often, especially with large objects, this is unnecessary. Instead, the model

Material can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. This feature of
Objet Studio is called “Hollow.” You can set the thickness of the shell —
between 0.015 and 3.825 millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
¢  On the Model Toolbar, click o
or—
* From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties E|
Grid Style Hollcnwy
(%) Standard
() Heavy Shell Thickness: 1.35
" Lite

Figure 5-56: Advanced Properties dialog box
3. Set the shell thickness, in millimeters.
4. Click Apply.
Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.
To inspect, change or cancel the Hollow setting:
1. Select a model on the tray.
2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.
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Displaying the  The Section feature enables you to view the interior of an object by “slicing”

Cross Section it on any axis. You can then manipulate the object to inspect the interior

of Objects from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 40). Displaying an object’s cross section only affects how
the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Section |X|

Section |

#

-

28
:| |
Z:|

¥ Enable Clipping

Figure 5-57: Section dialog box

2. Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that
you see the cross section you want.

Figure 5-58: Whole view Figure 5-59: Cross-section view, after
using the Z-slider
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Image File
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Press Ctrl+B.

or—

To save the screen display as an image:
1.

You can save the image displayed in the active viewing screen as a graphic
Screen Display file.

From the Objet Studio Commands Menu menu, select Save Bitmap.

The Save Bitmap dialog box opens.

Save Bitmap @
Savein | STL Fies | i i
=200 [0 To Last Folder Yisited]
Iz-0148
*Apnllcatlons - Tab Coating.bmp
*Traya.bmp
File: name: ‘Applications - Tab Coating
Save as twper | Bitmap [ brp] Cancel
DataType: [RGB True Color  (24-bil) [=]
Compression: ‘ Mon-Compressed ﬂ

Figure 5-60: Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.
At the bottom of the dialog box, enter a file name.

Open the Save as type pull-down menu, and select the file format.

Click Save.
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Exporting and
Importing
Objet Build
Trays
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When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Eden printers for
displaying and producing the st! files used on the tray. To conveniently
save all of the files that comprise the build tray, for storing the job, or for
transferring it to another location, Objet Studio compresses them into one
objzf file. To later use the objzf file, the file must first be expanded in Objet
Studio and its component files saved.

Note: If you export an objzf file containing a stl file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the
read-only stl file is saved.

To create an objzf file:

1. From the Objet Studio Commands Menu menu, select Export Packed
Job.

The Save As dialog box opens.
2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:

1. From the Objet Studio Commands Menu menu, select Import Packed
Job.

2. In the Open dialog box, display the appropriate folder and select the
file.

3. In the Browse for Folder dialog box, display the folder in which you
want Objet Studio to expand the compressed file, and click OK.

The objtf file and associated st files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

* Creating a quick-access toolbar for frequently used commands.
* Changing the position of the Quick Access toolbar.

* Minimizing the ribbon.

* Changing the Objet Studio color theme.

* Configuring default settings for objects placed on the build tray.

Creating a As you work with Objet Studio, you may use certain commands frequently.
Quick Access You can create a quick-access toolbar to make your work easier.
Toolbar

To create a quick-access toolbar:
1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.

Customize Quick Access Toolbar
Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-61: Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.

An icon for the selected command is added to the toolbar.

e O

Tray Setkings Job Mana

B B ¥s 6

Insert || Placement Yalidate [Estimate Biuild

Model Build Process

Figure 5-62: Quick Access toolbar

To add another command, repeat the above procedure.
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Hiding the
Ribbon
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4.

5.
6.

3. To choose from a wider range of commands:

From the Customize Quick Access Toolbar menu (see figure 5-61 on
page 45), select More Commands.

or—

* Right-click on the Objet Studio Commands icon, or elsewhere on the
ribbon, and select Customize Quick Access Toobar.

Cuskomize Quick Access Toalbar, ..
Shiowe Quick, Access Toolbar Below the Ribbon
Minimize the Ribbon

Figure 5-63: Right-click ribbon menu
The Options dialog box opens.

Options g]
[ custonize || Chosse commands rom:
Popular Cormands |42 Job Manager.
Commands
<Separator>
@ Automatic placement
> Buid
5 Insert Model
2 e -
& Open
& Placement validation -
B sane
[ Show Buick Access Taolar below the Ribbon
Keyboard shortcuts:

Figure 5-64: Quick Access Toobar Options dialog box

Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

Select a command and click Add.
Click OK.

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.

To hide the ribbons:

1.

Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands Menu () -

Select Minimize the Ribbon.
The ribbons disappear, but you can temporarily display the ribbon

icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:

> Repeat the steps above to cancel Minimize the Ribbon.
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Display Colors
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You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:

1.

From the Tools menu, select Define Colors.
The Define Colors dialog box appears.

In the Define Colors dialog box, click the color patch you want to
change:

* Tray Color.
* Background Colors.

e Selection Color.

Define Colors gl

Click the color patch you want to change,
and in the dialog box that opens,
zelect a color from the menu.

Tray Calor I:I
Background Colors I:I I:I
]

Selection Color

(%) Show Color According to Material
() Color According to Finish

[ Ok l [ Cancel ]

Figure 5-65: Define Colors dialog box

In the Color dialog box, select one of the Basic colors.

or—

Click Define Custom Colors to expand the dialog box and allow you to
define a customized color.

Basic colars:

B = e
HfTETHNN
ENNEENEEN
ENEEEENEN
EEEEEENN
EEEENE

Custom colors:

N T T Y I

Hue: Red:
mnininnin= celiia] com(25]
Define Custom Colors »> ColarSolid ) |y Blue:

[ 0] ] [ Cancel ] [ Add to Custom Colors ]

Figure 5-66: Color dialog box (expanded)

4. Click OK when done.

The patch color in the dialog box changes according to your selection.
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Changing Color Objet Studio offers a choice of four background color themes—blue, black,
Themes silver and aqua.

o T

D EVIE B B

Figure 5-67: Background color themes

To change the color theme:

* From the Style menu, select one of the options.

Keyboard You can define shortcut keys for frequently used commands.

Shortcuts To define shortcut keys:

1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.
&

Customize Quick Access Toolbar

Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-68: Customize Quick Access Toolbar menu
2. Select More Commands.

The Options dialog box opens (see figure 5-64 on page 46).
3. Click Customize.
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Setting User
Preferences

DOC-32011 Rev. A

6.

The Customize Keyboard dialog box appears.

Customize Keyboard E‘
Categories: Commands:
~
Frint Preview Build Properties |
Amrange Tray Default Properties.
Model Settings Exit
Job Manager Export PackedJob... =
Import Packed Jab...
Job Manager...
I achine Properties w
Current Feys: Press new shortcut key
Home
Aszigned to:

[Unassigned)

Set Accelerator for:

¢ )
Description:
Build

Figure 5-69: Customize Keyboard dialog box

Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.

Current shortcut keys are displayed.

Enter the shortcut key in the Press new shortcut key field, and click
Assign.

If you want to redefine all shortcut keys, click Reset All.

You can change several Objet Studio settings that affect objects placed on
the build tray.

To change default settings:

>

From the Objet Studio Commands Menu, select User Preferences.

User Preferences rg|
Building Style Grid Style
(3) Matte (%) Standard
() sy (I Heawy
O Lite
Application Settings
[Lock Orientation
ot

Quality:

Figure 5-70: Setting work preferences

Building Style —see “Surface Finish” on page 16.
Grid Style—see “Using a Grid to Position Objects” on page 22.

Application Settings —see “Choosing the Support Strength” on page 40,
and “Freezing Model Orientation” on page 27.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
» Open the Tools menu.

Tools =|style - (@) -

Grid
Snap ko Grid

Constrainks Setkings...

Section

Flane alignment 3

V' | Professional Mode

Language...
Options. ..

Define Colors, ..

Figure 5-71: Tools menu, showing Professional Mode selected
If Professional Mode is checked, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

! E The configuration changes vou have made will not take effect until the nest time wou run the application,
-

Figure 5-72: Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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You can control the default settings of several Objet Studio features from
the Advanced tab of the Options dialog box.

To display the Options dialog box
» From the Tools menu, select Options.
or—

In the Objet Studio Commands Menu, click Options.

Options g|
Appearance Grid M anipulate Dizplay
Settings Advanced Troublezhooting

[ suto Zoom

Orient Objects dutamatically

[ Ok H Cancel ]

Figure 5-73: Options dialog box, Advanced tab

By default, when Objet Studio places objects on the build tray, it orients
them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 17). In any case, when objects
are on the build tray, you can change their orientation manually, if
necessary —see “Model Orientation” on page 19.)

To change the default setting so that Automatic Orientation is disabled:
» In the Advanced section of the Options dialog box, clear the check box.

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 35).
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Open GL The OpenGL driver displays 3-D graphics on your screen. There is

Driver normally no reason to adjust its settings. If you suspect a problem with the

Configuration  way Objet Studio displays objects, you can use the OpenGL Driver
Configuration tool to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Troubleshooting tab.

Options g|
Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

OpenGL Driver Configuration. ..

[ (] 8 ][ Cancel ]

Figure 5-74: Access to GL-driver configuration

The Troubleshooting tab is only accessible when Professional Mode is
active (see Professional Mode Features).

3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.

X

OpenGL Driver Configuration

Window Pixel Format | Memony Pixel Format | Advanced

() Pixel Format D

(¥ Choose Format | Option 1 v
Color Bits 24
[epth Bits 32
Alpha Bits 0

[ Ok H Cancel ]

Figure 5-75: OpenGL Driver Configuration dialog box

5-52 DOC-32011 Rev. A



Eden260V User Guide

If you want to display the values and change them, click |:|
Alternately, you can select Choose Format and change the values in this
dialog box.

To perform a test of the driver configuration and enter the suggested
pixel format ID:

1. Select Choose Format.
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Objet Studio 3

-
\ll) Choose Pixel Format: 5

Figure 5-76: Recommended pixel format ID
3. Click OK.

In the OpenGL Driver Configuration dialog box (figure 5-75), select
Pixel Format ID and enter this number.

Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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Depending on your requirements, you may occasionally need to check that
model scaling is accurate. If there is a deviation of 300 micrometers or more
from the required measurements, you can adjust the scaling of models sent
to the printer to reduce this deviation.

Note: Calibration is only enabled if you are running Objet Studio in its
server configuration (see “Monitoring and Managing Print Jobs” on
page 57).

Model tests and scaling calibrations should be done separately for
materials with different characteristics. For example, if you calibrate Objet
Studio for printing with VeroWhite (a “Rigid” material), the printer will
print models accurately with all “rigid” materials. To ensure accurate
printing with materials in another family, you need to calibrate with a
material in that family.

To check model scaling:

1. Make sure that Professional Mode is selected in the Tools menu.

2. Make sure that the build tray is clear.

3. From the Tools menu, select Model Scaling > Load Tray for Calibration.
Objet Studio places the calibration model for your printer on the build
tray.

g\. ot Shuo! (DN 3 Sea
Toay St b Marager U~ Y - Dhwct ~ Jock - e -

‘b&:*i"""‘f""

P i e

o

B o ateg e
Mkl | pukdFrcim et Tie = - Gl Ol boin FUANTID Dt ww st gondnkin

| Madel Tree 1

Puacment sacomeded Mo | M

Figure 5-77: Calibration model on the build tray

4. Select the model and set its finish as Glossy (see “Surface Finish” on
page 16).
5. Perform Automatic Placement (see page 18).
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6. On the Tray Settings ribbon, in the Build Process group, click l;%;

The tray is sent for printing. (See “Monitoring and Managing Print
Jobs” on page 57.)

After the printed model cools to room temperature, remove it and
carefully measure the X- and Y- dimensions with a micrometer
(caliper). If there is a deviation of more than 300 micrometers (0.3 mm)
from the expected measurement, calibrate the model scaling.

To calibrate model scaling:

Make sure that Professional Mode is selected in the Tools menu.

2.  From the Tools menu, select

Model Scaling > Model Scaling Calibration.
The Model Scaling Calibration dialog box opens.

Model Scaling Calibration g|
Test Build Specifications

(%) High Quality

(") High Spesd

Material | BE

Rigid
Dlurustwihite | IMPORTAMT:
FullCurer20 Calibration must be done

MEDET0
RG0S5 separately for each mode.

“eroBlack
YeroBlue
YeroClear

Werolrew b

Reguired Meazurement Actual Measurement

#, [mm):

' [mmm): ﬂ

Figure 5-78: Model Scaling Calibration dialog box

Select the model material used for printing the calibrated model:

For High Quality or High Speed mode, the dialog box displays all of
the model materials included for this calibration.

Enter the model’s nominal measurement in the Required Measurements
fields. (These measurements are on the face of the printed model)

5. Enter the Actual Measurement.

To calibrate only one axis: For the axis you do not want to calibrate, enter
the same value in both the Actual Measurement field and in the Required
Measurement field.

6. Click Calibrate.

Objet Studio adjusts the printer’s scaling parameters for the material
and mode used in the calibration procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen information, as you work.

To view Objet Studio Help:
* PressF1.
or—
On the standard toolbar, click L7l and then click Objet Studio Help.

t o= Tools = Style = @ -

Chjet Studio Help

Troubleshooking
Direct Printing Plug-In

Check For Updates

g Abodt,,,

Figure 5-79: Help options
You can also view information on the following subjects:

* Troubleshooting opens a list of error messages and their
explanations.

* Direct Printing Plug-in opens information on additional software
programs that extend the capabilities of Objet Studio.

*  Check for Updates checks if you are using the latest Objet Studio
version.
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Monitoring and Managing Print Jobs

W=

Job Manager
Screen

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3-D
printer —the server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3-D printer server from that computer, and it
allows the user to edit only these jobs.

Note: If there are several Objet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific
3-D printer (server), displays the queue and status for all jobs sent to
that 3-D printer by the server and by all client computers on the
network. It also allows editing and manipulation of all jobs, and enables
re-sending previously-printed jobs to the printer.

If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any Objet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.

The Job Manager screen on the client and server workstations looks
identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.

o
Job Manager__| S ey
Ribbon et st het i e 4
e S Py——
Jobs Queue—]
''''' / Available
Print Progress— LIl — resources
3 1
o - - » . Material
Print History—| e S consumption
Waste status |2t
| | Tray Preview
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Figure 5-80: Job Manager screen

The Job Manager screen is divided into panels:
* Jobs Queue

¢ Print Time

* History

* Available Resources

* Material Consumption

¢ Tray Preview

* Waste
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Jobs Queue

Print Time

History

Available
Resources

Material
Consumption

Tray Preview

Waste

On the server, the Jobs Queue lists the last 15 jobs sent from client
computers. On client workstations, the Jobs Queue lists jobs sent from that
computer to the printer server.

Information for each of the queued jobs is displayed, including the job
status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be

continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing  The 3-D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting
position, UV lamps are turned on, and the build tray level
is adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
* Owner—the computer that sent the job.
* Build Time—the estimated building time for the job.

*  Model Consumption—the amount of model material required to
complete the job, and the amount actually used till now.

*  Support Consumption —the amount of support material required to
complete the job, and the amount actually used till now.

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Available Resources panel contains graphic indicators that show the
amount of available printing material remaining. If you move the mouse
over an indicator, the exact amount is displayed.

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 67).

If you move the mouse over the Waste display, the amount of waste in the
container is displayed.
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Setting the When an Objet 3-D printer is installed, the server computer is connected to
Printer that printer. Normally, there should be no reason to change this connection.
Connection Occasionally, however, you may need to reset the connection, to connect

the server to another printer, or to use Objet Studio in off-line mode
(without a printer connection).

To set (or change) the printer connection: )
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,
2. In the Set Printer dialog box, click Connect.

X

Set Printer

Printers:

0K
(EDEN 260v v | [Connect..

s

Figure 5-81: Connecting to a printer (A)

3. Enter the computer name or its IP address, or click Browse to find and
select it.

Enter printer name/|P address.

CBromse.. |

Usze ‘Unknown' for off-line mode.

Figure 5-82: Connecting to a printer (B)

4. Click OK.

When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

Objet Studio is connected to the printer if you can see the material levels in
the Job Manager screen (see Figure 5-80 on page 57).
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Off-line Mode  You can use Objet Studio to prepare trays for printing in off-line mode, on
aremote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.

To disconnect Objet Studio from the printer: )
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,
2. In the Set Printer dialog box, click Connect (see figure 5-81).

X

Set Printer

Printers:

0K
(EDEN 260v v | [Connect..

2

Figure 5-83: Disconnecting Objet Studio from a printer (A)

3. In the Printer Connection dialog box, delete the computer name/IP
address.

Enter printer name/|P address.

CBromse.. |

Usze ‘Unknown' for off-line mode.

Figure 5-84: Disconnecting Objet Studio from a printer (B)

4. Click OK.
“Unknown” appears in the printer-name field.
5. Click OK.
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6. Inthe pop-up message, confirm that you want to work in off-line mode
by clicking No.

M Job Manager

i ) Ohijet Studio is in off-line mode.

Do wou want ko connect ko a 30 prinker?

Figure 5-85: Off-line message
When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.

To change the Objet Studio off-line configuration:
1. In the Set Printer dialog box, select a printer type.

Set Printer, [gl
Printers:
Eden 2600w [Connect...]
Cancel
Connex260
Connex3al
Connex500

Eden 250 o«
E den 260V [
Eden 3500

Eden 500V =
Dbjet24

Ohijetan

Figure 5-86: Off-line printer selection

2. Click OK.
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Setting the
Remote Printer
Connection
(Client Mode)

Job Manager
Commands
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When you open Objet Studio for the first time in a client installation, you
are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1. On the Job Manager ribbon, in the 3D Printer group, click

Connect*

2. Enter the name of the server computer or its IP address, or click Browse
to find and select it.

3. Click OK.

Specify Server Computer name/|F address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-87: Printer Server Connection dialog box

The Job Manager ribbon has three icon groups:
¢ 3D Printer
* Queue
e Job
® o FaldH|e

Connect Motifications Top

Ok ¥EL
Up  Down Bokbomn | Restart Stop Resume Delete Wiew  Edit
30 Printer Queue Job

Figure 5-88: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
you cannot stop printing a job that is not being printed, so the Stop
command is disabled.

DOC-32011 Rev. A



Eden260V User Guide

DOC-32011 Rev. A

The following operations are available on the Job Manager ribbon:

Group Icon

Purpose

3D

Printer Conneck

Client: Sets the server connection. See “Setting the Remote
Printer Connection (Client Mode)” on page 62.

Server: Sets the printer connection. See “Setting the Printer
Connection” on page 59.

- Configures options for printer alerts. See “Configuring User
mrieaions. Alerts” on page 65.
Queue I£| Server: Moves a job to the head of the Jobs Queue.
Top Client: Disabled.

See “Jobs Queue” on page 58.

Server: Moves a job to a higher position in the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 58.

Server: Moves a job to the bottom of the Jobs Queue.
Client: Disabled.
See “Jobs Queue” on page 58.

Server: Moves a job to a lower position in the Jobs Queue.
Client: Disabled.

Bl
See “Jobs Queue” on page 58.
Job g, Server:

Restark

* For ajob in the Jobs Queue—Prints it again (from the
beginning).

* For ajob in the History list —Moves it to the Jobs Queue
for printing.

Client: Disabled.

See “Restarting Jobs” on page 68.

Server: Stops a job in progress.
Client: Disabled.

Skop

@ Server: Continues printing the current job from the point
. where printing stopped.

=N S

Client: Disabled.
See “Resuming Jobs” on page 68.

Removes the selected job from the queue.

Delete

“&  Refreshes the image of the selected job in the Tray Preview
= display.

View

. Opens the Tra Settinfgs screen and displays the tray. For

%= deleted jobs, this enables you to make changes before

Edik printing.
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In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Restart

Stop J & Ei— Delete

» i
Edit ¢ b b\—— Resume
Export - Schedule
packed job

Figure 5-89: Icons on pop-up toolbar (server)

E Delete

Edit ——— .

Figure 5-90: Icons on pop-up toolbar (client workstation)

%( When you position the cursor over an item, a tooltip displays the name of

the command.

Job = Tools = Skwle -

% sStop...

*. Delete Job...

Show 3dProgress

. Export ...

Figure 5-91: Job menu options (server)
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Configuring
User Alerts
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.
* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.

Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

et
1. On the Job Manager ribbon, in the 3D Printer group, click Hetfieations

Notifications El
Sound Alert
@ (5) Woice Messages (3 PC Speaker
7

Fieport to Printer

HP Desklst 3300/9320/9350 [ Pines. |
Fiepart to e-mail
dd Recipient

Remove Recipient

Add Recipient

[] Riepot via SMS

Q RemindMe 15min | Before Cartridges Emply

Q RemindMe 100g | Befors Cartridges Empty
oK. Cancel

Figure 5-92: Notifications dialog box (server)

Notifications @

Sound Alert
@ @) Voice Messages ) PE Speaker
28

[ Report to printer

Fieport to e-mail
#dd Recipient
Remove Recipint

[ Report via SMS

Figure 5-93: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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Printing the
Tray

Additional
Server
Features
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3. Click Details.

4.
5.

Select Events to repart on;
Sucoessful job finish
Job interruption

End of kMaterial rerminder

I Ok ] [ Cancel ]

Figure 5-94: Event selection for alerts

In the Reports Events dialog box, select the alert events and click OK.

In the Notifications dialog box, click OK.

If there is a job in the Jobs Queue, it is sent automatically to the Eden
printer—as long as it is on, there is a connection to the printer, and the
printer is on line. Chapter 6 describes starting and operating the printer.

Object Studio on the printer servers includes the following additional
features:

These features are described on the following pages.

Extended Tray Preview

Editing Jobs

Restarting Jobs

Resuming Jobs

Scheduling Jobs

Exporting Jobs (objzf)

Modifying the Job Manager Screen
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Extended Tray Preview

In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

Objet Studio s

¢
IO e @D

Ready !
Figure 5-95: Job Preview

* To change the tray magnification, turn the mouse wheel.

* To view the tray from a different perspective, click the relevant icon.
* To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you don’t want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5tl

| Info | Options | Build

Exclude from Build

0Objet Studio

' : Are you sure you wank o exclude this model from build process?
L

[ ‘es ] [ Mo ]

Figure 5-96: Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.
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To display printing progress in the Tray Preview pane:
» From the Job menu, select Show 3dProgress.

%( This option uses additional system resources.

Editing Jobs

You can open jobs in the Jobs Queue for editing.

To edit a job:

1. Select the job. -

2. Click the Edit icon o .
The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. Edit the job. s
On the Tray Settings ribbon, click e -
The status of the job in the Job Manager screen changes back to
“Waiting.”
Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.
To restart a job:
1. Select the job. :
e
2. Click the Restart icon restart .
The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job. _
2. Click the Resume icon esme.
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select ajob in the Jobs Queue, and click € on the pop-up toolbar.
2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.
f X

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
B apiizonn 3

Sun Mon Tue Wed Thu Fri Sat |-
T2 3|

4 5 B 7 & 9 10

[ 12 13 14 15 16 17
18 19 20 21 22 23 24

28026 27 28 29 ;W J

—2 Today: 4/11/2010

Figure 5-97: Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

For an explanation of objzf files, see “Exporting and Importing Objet Build
Trays” on page 44.

To export a print job:

1. Select a job.

2. On the pop-up toolbar, click &

3. In the Save As dialog box, selg a folder.
4. Click Save.

Moditying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel
* the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

* C(lick again to display the panel.
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Operating & Maintaining the Eden260V 3-D Printer

Printer cover

Model-material
compartment

Filter compartment

Support-material &
waste compartment

Figure 6-1: The Eden260V 3-D Printer

Starting the Eden260V Printer

& CAUTION!

¢ Do not attempt to operate the Eden printer before being trained by a
customer-support representative.

® Observe all safety warnings and follow the safety guidelines described
in chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power cable and switch

When the printer turns on, so does the built-in computer.

2. After the computer boots, log in to Windows and launch the printer-
control application:

® On the computer desktop, double-click the Eden260V icon.
or—
® From the Start menu, select Objet > Eden260V.

printer computer. This is installed at the factory or during printer upgrade. If
the application does not open and a HASP message appears, contact your
dealer or Customer Support.

% A HASP plug containing a valid product activation key is required on the
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The Eden printer interface screen opens (see figure 6-3). All monitoring and
controlling of the printer is done from this interface.

05Jan 2010  16:06

Printer mode——§&—— e B8 — Current activity

I» Previous job last slice: 1081

FullCure705  FullCure705 VeroBlack VeroBlack

Model material

Support material
cartridges

cartridges

Display
toggle button

Online/offline
button

Pause button

Figure 6-3: Eden260V interface

running Objet Studio and the computer installed inside the printer. Make
sure that the KVM (keyboard-video-mouse) switch is in the correct position

% Eden installations utilize one monitor for displaying both the computer
so that the printer interface is displayed.
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Loading Model and Support Cartridges

=

64

Eden260V printers use two cartridges of model material and two cartridges
of support material, each weighing 3.6 kilograms when full. A graphical
representation of the cartridges and their current weight appears in the
printer interface (see figure 6-3).

The printer uses RFID technology to automatically identify the material
cartridges. For this purpose, an RFID module is part of the printer hardware.
Tampering with this module will render the printer inoperable and may void
Stratasys warranties and service contracts.

Important: If you need to replace the model material currently
installed with another type, see “Changing the Model Material”
on page 6-10. Otherwise, make sure to replace the model
cartridge with one containing the same type of material.

To load model and support cartridges:

1. On the front of the printer (see figure 6-1), push the door of the relevant
storage compartment to release and open it.

2. If you are replacing a cartridge, grasp its handle and pull the cartridge
out, taking care not to twist or turn it.

3. Load model and support cartridges into their respective
compartments. (Note that the cartridges only fit into their correct
compartments.)

You should feel some resistance, as a needle pierces the cartridge.

4. Check the printer interface to make sure that the new cartridge is
detected and that its weight is displayed (see figure 6-3).

5. Close the storage-compartment door.

Tips about replacing cartridges:

® You can replace material cartridges either before or during printing.

® |f printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens,
see “Resuming Production After Printing has Stopped” on page 9.

® You can replace partially used cartridges to avoid the need for replacing
them during printing.

® You can load partially used cartridges, as long as they contain more
than 100 grams of material.
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Producing Models
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The Eden260V printer produces models by printing tray files prepared in
the Objet Studio application and sent to the printer from there. For
information about preparing model files for printing, see “Using Objet
Studio” or Objet Studio Help.

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
“Pattern Test” on page 21).

To prepare the printer for producing models:

1. Make sure that the build tray in the printer is empty and clean. If not,
remove old material with the scraper, and clean the tray thoroughly
with cleaning fluid.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2. Make sure that there is sufficient model and support material loaded
in the printer, as indicated in the printer interface (see figure 6-3). You
may want to replace the cartridges of model and support material
currently loaded in the printer to avoid the need for replacing them
during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 6-4.

For changing the type of model material currently loaded, see
“Changing the Model Material” on page 10.

3. At the bottom of the printer interface, click the red button to switch the
printer to online mode.

The color of the button changes from red to green (see figure 6-4). If
there is a job in the Job Manager queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

® The print block is heated.
¢ The UV lamps are powered and they warm up.

When printing begins, Objet Studio sends seven slices to the printer. This is
the standard buffer between Objet Studio and the printer. As each slice is
printed, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough model
and support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Eden printer. Do not log-off Windows until printing is
finished.
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The Eden260V printer uses one model-material cartridge and one support-
material cartridge to produce models. When four cartridges are loaded in

the printer, two of them are reserve, or standby, cartridges. By default, the

printer first uses the cartridges with the least material in them.

> The active cartridges are blue in the printer interface.

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface
screen.

e e —————
@]ET 05Jan2010 16:25 !

Block temp. . f Block temp.
behind ) behind model
support heads heads
) f Temp. of each

Temp. of each

support head model head

AEaEAE s anm

Block e, c—Bloctemp.
support heads heads
Waste weight Waste (gr) Heads Liquid Suppqrt/Model
Chamber temp. LR B B Syetem
Left UV lamp vacuum level

Pre-heating of
support & model
material

Display

toggle button

Right UV lamp

ED=N 260V

Printer set to
offline mode (red)

Figure 6-4: Printer indicators
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Printer
Interface
Color Key
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The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.

® Green—suitable/ready for printing
For example, in figure 6-4:

O Ambient—The ambient temperature of the printing chamber is
within the acceptable range.

O Heads Liquid—The level of model and support material in the print-
block reservoir is OK.

O Heads Vacuum—The vacuum level in the system is within the
acceptable range.

O Pre-Heater—The model and support resins need to be heated before
being supplied to the print block. The temperature has reached the
acceptable range.

® Red—not suitable for printing (or indicates a warning)
For example, in figure 6-4:

O Waste—The weight of the waste container is 7300 grams, more than
allowed when beginning a print job. (See “Replacing the Waste
Container” on page 6-61.)

® Blue—not ready
For example, in figure 6-4:
0 UV lamps—The UV lamps are not on.

O Heads (°C)—The heads have not reached the temperature required
for printing models (in printing mode).

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

® Blue—active cartridges

® Gray—reserve cartridges
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Printing The printer interface screen changes when you send a print job from Objet
Indicators Studio to the printer, and the printer is on line (see figure 6-5):

® The mode changes from Pre-print to Printing.

® The specific activity being performed is shown in the “current activity”
field.

¢ Current job-printing information is displayed.
® The printing progress bar is displayed.

® The Stop and Pause buttons are enabled.

When the weight of a cartridge drops below 100 grams, the display of the
material level in the printer interface is red.

@]ET 05Jan2010  16:36 !

Printer mode—§— _ Printing ! Current Activity

@ Print Time 00:06:27 — Slice 3 of 30 (10.0%)

Job information <- ob information

T Height 0.11mm of 0.96mm 1> Previous job last slice: 3

FullCure705  FullCure705 VeroBlack VeroBlack

Progress bar

Stop button Pause button

Figure 6-5: Printer interface during printing
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Resuming Production After Printing has Stopped

3

Printer mode

DOC-32011 Rev. A

If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don't replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

After printing stops, the printer goes into Standby mode, when heating of
print heads is reduced. About 10 hours later, the printer goes into Idle mode,
when heating of print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see figure 6-3 on
page 3).

The button changes from red to green (see figure 6-4 on page 6).

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Job Manager screen of Objet Studio, click the Resume icon e

Resume *

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

OQ]ET 10 Jan 2008 17:36

| Print Time 00:20:51 ._ | Slice 168 of 1013 (16.6%)

Last slice
Height 4.87mm of 29.37mm Previous jok last slice: 168 printed

Figure 6-6: Printer interface after interrupted printing

Continue from Slice: [

163

Ok | Cancel |

Figure 6-7: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.

You cannot continue printing the model if:

® The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

® There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
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printing stoppage on a model depend on the model size and structure,
model material used, ambient temperature and the length of the

stoppage.
If you cannot continue printing:
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Send the job to the printer again.

You can stop and later resume printing from either the printer interface or
from the Job Manager screen of Objet Studio, since both applications are
updated when you use these commands. However, after clicking the Pause
button in the printer interface, you can only resume printing from the printer
interface.

Changing the Model Material

6-10

=

Before producing models using a different type of model material (resin)
than is currently installed, run the Material Replacement Wizard to flush
the print block and feed tubes.

You should carefully plan printing models with different model materials to
avoid unnecessary waste of the material loaded in the printer. The amount
of material flushed depends on the flushing cycle chosen and if you are
replacing one or both cartridges.

To replace the model material:

1. Start the Material Replacement Wizard from the Options menu.

Help
Go ko Tray Upper Fosition FS

Go ko Purge Pasition F& 05.Jan 2010  16:44

wipe

F7

Execute Purge Sequence

F4

Pattern Test

F3

EBuilk In Tests...

Chrl+HAl+E

Mainkenance Counkers...
Collect Service Data

Fz

T Height 0.38mm of 0.96mm

FullCure70§  FullCure705

e merit
Wiper Clearing
Head Cleaning
Uy Callbration
U Lamp Replacement

of 30 (40.0%)

fiead Alianment s job last slice: 12
Head Optimization
Load Cell Calibration

Shiutdown

VeroBlack VeroBlack

Figure 6-8: Starting the Material Replacement Wizard from the Options menu

In the opening screen, click Next.

If the printer cover is not closed, a screen appears instructing you to

close the cover. Confirm that it is closed and click Next.
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4. Inthe Compartment Selection screen, select an option for changing either
cartridge or both cartridges, and click Next.

Material Replacement Wizard

Compartment Selection

[] Right model-material compartment

[ Left model-material compartment

[] Right support-material compartment

[ Left support-material compartment

©OBJET

(K] >

Figure 6-9: Compartment Selection screen

5. From the drop-down menu, choose the model material you want to
install, and click Next.

Material Replacement Wizard

Material Selection

Selectthe new material for the 'model' compartment(s):

©BJET “WeroBlack

’ X Qancel] ’{Erevious” Mext g l

Figure 6-10: Material Selection screen

Note: This selection automatically affects the default material setting in
Objet Studio.
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6. In the Flushing Options screen, choose the appropriate cycle for the
model material you want to install.

Material Replacement Wizard

Flushing Options

GGG ) Choose the flushing cycle required:
"‘h..h_____‘.f‘"

(%) Econamy
(l (@51

O High-performance
’ XK Cancel ] ’{Erevious] I Mext = l

Figure 6-11: Flushing Options screen

Economy. During this cycle, which takes about 20 minutes, the
pump purges the model material from the print block, then flushes
the system with the new material.

Since traces of the previous material may be present in the first
models printed with the new material, this cycle is usually
acceptable when replacing a light-colored model material with a
darker material (such as TangoBlack™ or VeroBlack™), or if the
exact color of the printed models is unimportant. However, this
cycle ensures that models will have the mechanical properties of the
new material.

High-performance. During this cycle, which takes about 55 minutes,
the wizard cleans the feed tubes and print block more thoroughly
by flushing the system with more material.

This cycle ensures that models will have the color (and the
mechanical properties) of the new material, when replacing a dark-
colored material (such as TangoBlack or VeroBlack) with a lighter-
colored material.
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7. Click Next, and take note of the warning screen.

Material Replacement Wizard

Please note:

Beyond this point, selecting 'Cancel' will abort the Mizard

84'0 and disahle printing.
Frinting will be enabled only after completion of this
wizard
O8BIET
[ x Cancel ] [~(Erewousl | Mext g |

Figure 6-12: Material Replacement warning screen

models with the Eden printer. To perform the procedure at another time,
click Cancel. If you continue (by clicking Next) and you do not complete the
procedure, you must start the Material Replacement Wizard again before
producing models.

% Once you start this procedure, you must complete it before you can produce

8. To continue, click Next.

9. When prompted by the wizard screen, remove the material cartridge
and load the replacement cartridge for the required compartment(s).
Confirm and click Next.

Material Replacement Wizard

Remove Cartridge

Confirm before continuing:

[ Cartridge removed from right ‘model’ compartment.

’ x Lancel ] ’{Erevious]

Figure 6-13: Remove Cartridge confirmation screen
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If the printer does not identify the replacement cartridge(s), the
following wizard screen appears.

Material Replacement Wizard

I Required Cartridges Not Loaded
LEFT " RIGHT_
Feplace and confirm

[ Cartridge loaded in right ‘model’ compartment.

"

Figure 6-14: Prompt to load new model cartridges

After identifying the cartridge(s), the printer begins filling the print
heads with the new model material.

Material Replacement Wizard

Material Replacement in Progress

This process will take approximately 20 minutes

00:05
OBJET

Figure 6-15: Material replacement: filling heads with new material

10. When the final wizard screen appears, make sure that the screen
displays the newly-loaded material(s). Click Done to close the wizard.

& CAUTION: Dispose of all material cartridges in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling. If this is done, protect the person handling
the cartridges from direct exposure to uncured resins.

The printer-control interface is automatically updated, and should
display the new material(s). The Objet Studio interface (on the printer-
server workstation) is also updated.
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Keeping the Printer in Idle Mode

S
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Between printing jobs, the Eden260V printer can be kept on for up to one
week. If the printer will not be used for more than a week, use the
Shutdown Wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).

When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Time after printing | Mode Change in heating of print heads
first 15 minutes Standby 1 none

next 10 hours Standby 2 heating reduced (to room temp.)
after 10 hours Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 6-3, 6-4 and 6-5 on pages 3, 6 and 8).

If, after printing a job, you know that the printer will not be used for 10
hours or more, you can immediately turn off the heating of the print heads
by putting the printer into Idle mode.

To put the printer into Idle mode:

» From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Eden printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—uwith the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown Wizard (see below).
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Shutting Down the Printer

You only need to shut down the Eden printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode. To
properly shut down, the printer needs to perform several processes. These
are controlled by the Shutdown Wizard. Do not attempt to shut down the
printer by simply closing the computer interface (the printer-control
application), and never disconnect power to the printer before
completing this wizard.

Depending on the length of time the printer will not be used, you can
choose between a short shutdown procedure, and a more thorough
procedure.

® Up to 10 days: The wizard empties the print block of model and
support material, to prevent leaks. This takes about 10 minutes.

® More than 10 days: The wizard empties the print block, then flushes
the system with cleaning fluid. This takes up to 35 minutes, and you
must be present to load cleaning-fluid cartridges when instructed.

To run the Shutdown Wizard:

1. Select Shutdown from the Options menu, or press F8.

Shutdown Wizard

= N Shutdown Wizard

This wizard controls the processes necessary for shutting
down the printer.
Fress 'Next' to continue or 'Cancel' to quit.

Figure 6-16: Shutdown Wizard, opening dialog box
2. In the opening wizard screen, click Next.

3. Choose the appropriate option for the length of time that the printer
will not be used —less or more than ten days.

Note: Before selecting More than 10 days, make sure that cleaning-fluid
cartridges are available.

4. In the next screen, verify that the tray is empty and click Next.
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The shutdown procedure begins.

Shutdown Wizard

L

ShutDown
Process

OBJET

2 Help

Shutdown in Progress

o
o
o
[

Figure 6-17: Shutdown progress screen

When the final wizard screen appears, close the printer-control

application and shut down the built-in computer.

Shutdown Wizard

L

&

©BJET

Shutdown Procedure Completed

You may now shut down the printer computer and turn off
power to the printer,

Figure 6-18: Final Shutdown Wizard screen

After the printer computer shuts down, turn off the main power switch
(at the back of the printer).
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Maintaining the Printer

Routine
Maintenance
Schedule

6-18

The performance of routine maintenance tasks is essential for getting
satisfactory results from Eden 3-D printers. Perform the tasks at specified
intervals for optimum performance.

Frequency Task For More Information
Daily, before printing Clean the print heads. See “Cleaning the Print
Heads” on page 6-19.
Weekly Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 6-21.
Weekly Clean and inspect the See “Cleaning and
wiper. Replacing the Wiper”
on page 6-23.
Weekly Restart the printer
computer and the
server computer.
Weekly Clean the roller waste | See “Cleaning the Roller
collector. Waste Collector and
Inspecting the Roller
Scraper” on page 6-25.
Monthly, and after Check the alignment of | See “Aligning the Print
replacing print heads the print heads. Heads” on page 6-30.
Monthly Calibrate the load cells. | See “Calibrating the
Load Cells” on
page 6-49.
Monthly Inspect the exhaust
system (duct, fan,
connections).
Every 2000 hours of Preventive maintenance | Contact your

printing, or once a year

visit by authorized
service engineer.

support center.
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Cleaning the Periodic inspection and cleaning of the orifice plates on the bottom of the
Print Heads print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. This procedure takes about 20 minutes, and
should be done at the beginning of the work day or before a big printing
job.
To clean the print heads:
1. Prepare—
® isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
® disposable cleaning gloves
® a Stratasys-supplied cleaning clothor equivalent
® amirror

2. Start the Heads Cleaning Wizard from the Options menu (see
figure 6-25 on page 23).

3. Follow the instructions on the wizard screens, and select the check
boxes to confirm that:

® you have checked that the tray is empty.

® you have closed the cover.

Clean Heads Wizard Pz|
Clean Heads Wizard
Flease check if the tray is empty and close the
doar.
|
[v Tray iz empty
(@51
XK Cancel | =Z | Mext 3= |

Figure 6-19: Head cleaning procedure—wizard screen
4. Click Next.

The printer prepares for you to clean the print heads.
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5. When the following screen appears, open the cover.

Clean Heads Wizard

Caution:

are Hot!

Heads | |3

©OBJET

3

Are heads clean ?

Flease open the door and clean heads.

I” Heads clean

Figure 6-20: Head cleaning wizard—steps 5-10

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

O ® N

material.

Put on the gloves.

Place the mirror on the build tray.

Soak the cleaning cloth with the cleaning fluid.

Clean the orifice plates, with a back-and-forth motion (see figure 6-21).
Use the mirror to make sure that you have removed all of the residue

Figure 6-21: Cleaning the heads

the UV lamps.

% It is recommended that you use this opportunity to also clean the roller and

6-20
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Pattern Test
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10. When you have finished cleaning, select the confirmation check box in

the wizard screen (see figure 6-20) and click Next.

11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click

Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Clean Heads Wizard Pz|

Heads clean wizard completed

©OBJET

| =Z | JDonel

Figure 6-22: Head-cleaning wizard—final screen

13. Click Done to close the wizard.

The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:

1.

2.
3.
4

Make sure that the build tray is empty.

Prepare a sheet of pink paper— A-4 or Letter size.

In the printer, tape the pink paper to the center of the build tray.
Press F3, or open the Options menu and select Pattern Test.

9 Perform Pattern Test?
\_‘

Figure 6-23: Pattern Test confirmation

The printer prints a series of lines on the test paper (see next figure).
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Improving
Print Quality

6-22

Figure 6-24: Sample Pattern Test

5. Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, more than 10
missing lines in one area of a column is considered unacceptable.

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test” on page 6-21). If the results are poor, use the following
procedure to improve print quality.

If the results of the last pattern test are poor:
1. From the Options menu, select Execute Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the
wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.
If the results of the pattern test are still poor:

1. Manually clean the print heads (see “Cleaning the Print Heads” on
page 6-19).

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue
left on them.

2. Perform the purge sequence.

3. Perform the pattern test.
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Cleaning and
Replacing the
Wiper
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If the results of the pattern test are still poor:
» Optimize the print heads and replace faulty print heads. if necessary
(see “Calibrating Print Heads” on page 6-34).

A rubber wiper removes excess material from the print heads after the
purge sequence. This is done automatically before each print job, and
performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:
1. Prepare—
® jsopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
® disposable cleaning gloves
® a Stratasys-supplied cleaning cloth or equivalent
® aspare wiper

2. Start the Wiper Cleaning Wizard from the Options menu.

Help
Go ko Tray Upper Pasition FS

Gota Purge Position F6 05Jan 2010  16:45
Hhiipe: F7 :

Execute Purge Sequence

Pattern Test

Built In Tests... Ctrl+Al-+B Wi

WMaintenance Counters... U of 30 (40.0%)

Collect S Dat:; Fz
olect service Bata LW Lamp Replacement

T Height 0.38mm of 0.96mm Head Alanmeri s job last slice: 12
Head Optimization

Load Cell Calibration
Shutdown

FullCure705  FullCure705 VeroBlack VeroBlack

Figure 6-25: Starting the Wiper Cleaning Wizard

3. Close the printer cover, and click Next in the wizard screen.

4. Make sure that the build tray is empty, and close the printer cover.
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Confirm this in the wizard screen.

Wiper Cleaning Wizard

L Inspect the build tray
; Confirm before continuing:
Wip Tray iz inzerted
Cleaning

The build tray is clear [empty], the cover is closed.

(@511
Figure 6-26: Wiper Cleaning procedure—step 4
Click Next.

6. When the following screen appears, open the cover.

Wiper Cleaning Wizard

L Inspect the wiper
; Confirm before continuing:
Wip The wiper blade iz clean.
Cleaning
(@51

Figure 6-27: Wiper Cleaning Wizard during steps 7-10

Put on the cleaning gloves.

Using a generous amount of cleaning fluid and the cleaning cloth,
remove any material remaining on the wiper and the surrounding
area.

9. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. Grasp it and pull it up and out of its bracket.

b. Insert the new wiper blade, making sure that it is straight and secured
well on both sides.

10. In the wizard screen (see figure 6-27), confirm that the wiper blade is
clean, and click Next.

11. Make sure that you have removed all tools and cleaning materials
from the printer, and close the cover.
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Cleaning the
Roller Waste
Collector and
Inspecting the
Roller Scraper
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12. Select the confirmation check boxes in the wizard screen and click
Next.

Wiper Cleaning Wizard

. Wiper Cleaning wizard completed

e !

-

\

]

%

Figure 6-28: Wiper Cleaning procedure—final screen

13. Click Done to close the wizard.

The roller waste collector removes waste material scraped from the roller.
Suction removes this waste to the printer’s waste container.

This assembly should be cleaned weekly to prevent a blockage in the tubes
leading to the waste container, so that waste material does not overflow
into the printer.

To clean the roller waste collector:

1. Prepare—

M2.5 and M2 Allen keys

disposable cleaning gloves

isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
cleaning cloth

cotton swabs (Q—tips® or similar)

2. Put on the gloves.
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3. Remove the right UV-lamp assembly:

a. Disconnect the UV power cable and the fan power cable.

Power connector

Figure 6-29: Disconnecting the right UV assembly

b. Remove the screw attaching the right UV lamp to the print block,
and then pull and lift up the UV lamp.

4. Loosen the two screws securing the suction tube on the print block.

uction tube screws

Figure 6-30: Lifting the suction tube

5. Lift the suction tube to secure it in a raised position.
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6. Remove the two screws securing the covering of the roller waste
collector and remove it.

Be very careful to save the covering screws. These are special screws; if
they are lost you need to order replacements.

Roller waste
collector screws

Figure 6-31: Removing the roller waste collector covering

Remove the covering by pulling it out, and then lower it.

Clean the roller waste collector and the scraper blade surface using
cotton swabs. Make sure to remove any remaining printing materials.

Figure 6-32: Cleaning the roller waste collector

Before replacing the covering you can check the effectiveness of the roller
scraper—see below.

To check the effectiveness of the roller scraper:
1. Put on the cleaning gloves.

2. Wet a cloth with isopropanol.

3. Use the cloth to wet the bottom of the roller.
4

Turn the roller slowly with your hand. As the blade scrapes the roller,
make sure the isopropanol is spread evenly over the entire length of
the blade.

5. Inspect the roller. If it is not dry, replace the blade. (See “Replacing the
Roller Scraper” on page 6-28.)
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6. Before returning the roller waste collector to the print block, make sure
that the pins are clean.

Roller waste
collector pins

Figure 6-33: Roller waste collector pins

7. Return the roller waste collector to the print block and screw on the
covering (see figure 6-31 on page 6-27).

8. Loosen the screws securing the suction tube.

Securing screws

Figure 6-34: Suction tube correctly positioned

9. Lower it so that the hole in the panel behind the suction tube is visible,
and tighten the screws to secure the tube.

10. Attach the right-UV-lamp assembly to the print block and reconnect
the UV power and fan cables.
Replacing the  You should replace the roller scraper blade:
Roller Scraper o after 1,000 hours of printing.

e if it does not effectively keep the roller clean.

clean the roller waste collector. See “Cleaning the Roller Waste Collector

%( You should periodically test the effectiveness of the roller scraper when you
and Inspecting the Roller Scraper” on page 25.

To replace the roller scraper:

1. Prepare—
® anew roller scraper (knife) (KIT-01026-S)
® a Phillips 1x75 mm screwdriver
® M2.5 and M2 Allen keys

2. Remove the right UV lamp and the roller waste collector covering (see
steps 3 to 6 on page 6-26.)
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3. Loosen the two screws securing the roller waste collector and pull it
out.

Figure 6-35: Removing the roller waste collector

4. Remove the screws that secure the roller scraper assembly.

Figure 6-36: Removing the roller scraper screws

e
aean ™

il
= G\E,an e
.

Figure 6-37: Removing the old roller scraper blade

5. Remove the scraper blade and discard it.
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6. Place the new scraper blade onto the pins in the holder, as shown.

(oval hole
in blade)
=]

(round hole
in blade)
Q

Figure 6-38: Inserting the new roller scraper blade
7. Insert and tighten the roller scraper blade screws.
Important:

® Tighten the screws in the order shown in figure 6-39.
® Use the new screws supplied in the replacement kit.

B

Figure 6-39: Tightening the roller scraper screws

8. After tightening the screws, inspect the blade and make sure that it is
straight. If necessary, loosen the screws and tighten them again, evenly.

9. Return the roller waste collector assembly and the right UV lamp to
the print block. See steps 6 to 10, from page 6-28.

Aligning the You should check the alignment of the print heads—
Print Heads e once a month
® after replacing one or more heads

® if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see “Cleaning the Print Heads” on
page 6-19)

The head-alignment procedure takes about 20 minutes.
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To check the alignment of the print heads:

1.

Prepare—
® atransparency sheet—A-4 or Letter size

® any type of sticky tape, to fasten the transparency sheet to the build
tray

Start the Head Alignment Wizard from the Options menu (see
figure 6-25 on page 23).
Click Next to begin, and close the cover.

In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

When instructed to do so, place the transparency on the build tray —
next to the left and rear edges of the tray, as shown in the following
figure.

Figure 6-40: Positioning the transparency on the build tray

Make sure that the transparency sheet is lying flat, and tape it to the
tray.

In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.

When the following screen appears, remove the transparency.

=

Head Alignment Wizard

Remove transparency from tray

[~ Transparency removed

OBJET

? Hep |

Figure 6-41: Head Alignment Wizard—steps 8-10

<Z Previous | Mext 3= |
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10.

The transparency sheet is printed with sets of vertical lines in seven
columns, each showing the results from a different print head.

3 2 1 0 3 2 1

s LM

Figure 6-42: Sample head-alignment test

® The three columns on the right were printed by the heads used for
applying model material when producing models. From right to
left, the columns represent heads M1, M2, M3, respectively. (There
is no column for head MO because its alignment is used as a
reference for aligning all other heads.)

® The four columns of lines on the left were printed by the heads used
for applying support material. The columns represent heads S3, S2,
S1 and S0, respectively.

For each column of lines, use a magnifying glass or loupe to inspect
pairs of consecutive rows printed on the transparency to see where the
vertical lines align.

Alignment-line

12 1 3 B 7= numbering, left-to-right

3456
\“lxl‘n J'If
LTI

Row pair

Figure 6-43: Comparing rows of alignment lines

Note: It does not matter which pair of lines you inspect, since they were all
printed by the same head. Choose a pair of clearly printed lines for the
inspection. (Since some nozzles may not print clearly, you may have to
inspect several pairs of lines to properly view the alignment.)

Optimum head alignment is shown when the fourth lines in the upper
and lower rows are aligned, as in figure 6-43. In the example shown, no
change to the head alignment is necessary. If other lines in the set are
aligned, you need to change the alignment of that head —in the next
wizard screens.

In the wizard screen shown in figure 6-41, select the Transparency
removed check box, and click Next.
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11.

12.

13.

The first in a series of alignment screens appears.

@ |

Head Alignment Wizard Pz|

Head M1

Choose the best printed line n the transparency

©OBJET

? Hep XK Cancel | <€ Previous |

Figure 6-44: Head alignment screen

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows of a pair on the transparency
(counting from the left) for this print head.

Note: Because the alignment of the fourth lines is optimum, the number “4”
is selected, by default, in the wizard screen. This does not change the head
alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next to display the next head alignment screen, and again select
the number representing the most closely aligned vertical lines on the
transparency for that print head.

When you have finished aligning all of the heads, the following screen
is displayed.

Head Alignment Wizard Pz|

Updating System Parameters

my Do you want to update the system parameters?

+ ‘ez
6

? Help XK Cancel | <€ Previous | Lt

Figure 6-45: Update confirmation screen

™ Mo

Continue as follows:

® To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

® To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

¢ If you do not want to make alignment changes in the printer at this
time, select No and click Next.
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Print Heads
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14. In the final wizard screen, choose to either repeat the head alignment
procedure or close the wizard.

® If the most closely aligned vertical lines for a print head were at
either extreme —the first or seventh lines—choose Yes to run the
Head Alignment Wizard again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

® If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

@ A

Head Alignment Wizard g|

Do you want to repeat the test?

" “es - Print another transparency

* Mo - | want to end of Wizard

? Help XK Cancel | <€ Previous | Lt

Figure 6-46: Final Head Alignment Wizard screen

The condition of the print heads directly affects the quality of printed
models. To maintain optimum printing, you should routinely test the print
heads, and calibrate them to the best working configuration possible. You
do this by running the Head Optimization Wizard.

During the optimization process, 32 samples are printed on the build tray.
After carefully weighing each of them, you enter the weight in the wizard's
data-entry screen. The wizard uses this data to optimize the heads.

If, during the optimization process, the wizard determines that a print head
is faulty —or that it is negatively affecting layer uniformity with the current
head configuration—the wizard instructs you to replace it. If this happens,
you can continue the wizard (to replace the print head) or abort the wizard
(to replace the head at another time).

Run the Head Optimization Wizard whenever the condition of print heads is
negatively affecting the quality of printed models, or if you suspect that there
is a problem with one or more of the print heads.

To test and calibrate the print heads:
1. Prepare—
® jsopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
® disposable cleaning gloves
® a Stratasys-supplied cleaing cloth or equivalent
® amirror

® the scale supplied by Stratsys for use in the Weight Test
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2. Start the Head Optimization Wizard from the Options menu of the

printer interface.

Go to Tray Upper Position FS
Go to Purge Position F&
Wipe F7

Execute Purge Sequence

Pattern Test

Built In Tests... CtrH-AlE+E

Maintenance Counters. .,
Collect Service Data F2

T Height 0.38mm of 0.96mm

FullCure705  FullCure705

L

05 Jan 2010 1648

Material Replacement _
wiper Cleaning

Head Cleaning

LY Calibration of 30 (40.0%)

U Lamp Replacement
Head Alignment

Hez ian
Load Cell Calibration
Shutdovn

s job last slice: 12

VeroBlack VeroBlack

L

Figure 6-47: Starting the Head Optimization Wizard

3. In the opening wizard screen, click Next to begin.

The Wizard Conditions screen appears.

Read the conditions, select I Agree and click Next.

Close the printer cover, and confirm this in the wizard screen.

6. In the following screen, make sure Optimize all print heads is selected,

and click Next.

H

Select the procedure required

(%) Optimize all print heads.

() Replace faulty heads and optimize all heads.

©OBJET

’ x Qancel] ’{Erevious” ﬂext) l

Figure 6-48: Procedure selection screen

The print block moves into position for cleaning and inspecting the

print heads.
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7. When the following screen appears, clean the print heads.

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Head Optimization Wizard

. Clean the print heads
Caution:
Heads ﬁ!g Confirm before continuing:
are Hot! §&3
[ The print heads are clean.
(@511

Figure 6-49: Clean print heads screen
8. Place the mirror on the build tray.
9. Put on the cleaning gloves.
10. Soak the cleaning cloth with the cleaning fluid (alcohol).
11. Clean the orifice plates, with a back-and-forth motion.

Figure 6-50: Cleaning the print heads

Use the mirror to make sure that you have removed all of the residue
material.

12. When the print heads are clean, select the confirmation check box in
the wizard screen and click Next.
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13. Remove the cleaning materials from the printer, and close the cover.

Head Optimization Wizard

Inspect the build tray

Confirm before continuing:

[ Tray is clear and the cover is clozed.

©OBJET

’ XK Cancel ] ’{Erevious] T

Figure 6-51: Confirmation screen
14. Select the confirmation check box in the wizard screen and click Next.
The head-purge cycle runs, after which the Weight Test is printed.

Head Optimization Wizard

)
Oy

\ Printing Weight Test

This step can take up to 55 minutes.

01:52

OBJET

[(Xe) (< >

Figure 6-52: Printing Weight Test

32 samples are printed on the build tray, four for each of the print
heads. This can take up to 55 minutes.
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15. When the following screen appears, open the printer cover. Enter the
data that describes the condition of each print head, after inspecting
each of the printed samples.

Head Optimization Wizard

Weight Test Data Entry

Build tray map

0U0000000000L00LU
p0000000000LLLLS

Enter:

Mizzing Mozzles weight

I | | | Apply

©OBJET

’ Edit D ata ] ’ X Qancel] <2 T

Figure 6-53: Weight Test Data Entry screen

The layout of the data entry screen matches the printed samples on the
build tray. Enter the data for the sample indicated by € in the screen.

a. Enter the number of faulty (“missing”) nozzles.

Faulty nozzles are seen in Weight Test samples as a missing row of
printed material. Compare the height of the missing row with the
lines printed on the “missing nozzles” ruler. Enter the number next
to the line that most closely matches the height of the missing row.

Ruler

Missing line

Printed sample

Figure 6-54: Measuring the missing line in a printed sample
In the example above, you would enter “1” in the wizard screen.

b. Carefully remove the sample, weigh it, and enter the weight in the
wizard screen.

Be sure to remove and weigh the entire sample, even if it breaks into
several pieces.

c. Click Apply or press Enter.
The data-entry-indicator € moves to the next position.
d. Repeat these steps for all 32 samples.
To change an entry, click Edit Data, enter the correct data, and click Save.

16. When you have entered the all of the data in the wizard screen,
click Next.
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17.

The wizard uses the data you entered to analyze the condition of the
print heads, and optimizes them so they print models with a uniform
layer of material. If the heads are in satisfactory condition, the final
wizard screen appears.

Head Optimization Wizard

N Print-head Optimization
" Completed
CeJer
%

Figure 6-55: Final wizard screen, after optimizing print heads

However, if the wizard determines that a print head is faulty —or that it
is negatively affecting model quality with the current head
configuration —the wizard instructs you to replace it. In this case, the
following screen appears.

Head Optimization Wizard
Weight Test Results
M3, M2 defective.

(%) Replace defective head(s).

O Abort wizard.

©OBJET

Figure 6-56: Defective print heads found

Choose Replace defective head(s) if you are prepared to replace the print
heads now.

or—

Choose Abort wizard if you want to replace the print heads at another
time.

Replacing print heads is expensive. Replace them only after consulting with
an authorized customer-support engineer.

If you are replacing the print heads now, the wizard guides you through the
procedure when you click Next. Continue with “Preparing the Print Block”
on page 6-41.
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Replacing
Print Heads
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The condition of the print heads directly affects the quality of printed
models. You need to replace a print head if one or more of the following
symptoms occurs:

® The Head Optimization Wizard determines that one or more print
heads are defective. (See “Calibrating Print Heads” on page 34.)

® There are noticeable grooves in the surface of printed models.

® Visual inspection of the head reveals that its surface is damaged —
peeling or bubbles in the nozzle area.

® The printer interface displays a warning or malfunction message
relating to a print head —

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

The Head Optimization Wizard guides you through the procedure of
replacing a print head, and adjusts components of the printer to enable you
to perform it. Only replace a print head with the aid of the wizard. The
procedure takes 75—90 minutes, and consists of the following phases:

A. Identifying the head(s) needing replacement.

This is normally done by the Head Optimization Wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction
message indicates which head needs replacing.

=

Preparing the print block for head replacement.

This is done automatically when you run the Wizard.
Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

mEon

Performing head alignment.

To replace a print head:
Prepare—
® replacement print head(s)
® jsopropanol (IPA—isopropyl alcohol) or ethanol (ethyl alcohol)
® disposable cleaning gloves (included in the head replacement kit)
® a Stratasys-supplied cleaning cloth or equivalent
® aflat-head screwdriver (5 mm)
® the scale supplied by Stratasys for use in the We ght Test
Note: Make sure that you have these items before running the wizard.

2. Start the Head Optimization Wizard from the Options menu of the
printer interface (see figure 6-47 on page 35).

3. In the opening wizard screen, click Next to begin.

The Wizard Conditions screen appears.
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4.

5.

Preparing the 6.
Print Block

7.
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Read the conditions, select I Agree and click Next.

Head Optimization Wizard

Select the procedure required

() Optimize all print heads.

(%) Replace faulty heads and optimize all heads.

©OBJET

’ X Qancel] ’{Erevious” Mext I l

Figure 6-57: Procedure selection screen
Choose Replace faulty heads, and click Next.

Select the print head(s) needing replacement, and click Next.

Head Optimization Wizard

Select heads to be replaced

©OBJET

’ XK Cancel ] ’{Erevious] T

Figure 6-58: Head selection screen

The printer heats and empties the print block, and prepares the printer.
(This should take up to 30 minutes.)

Head Optimization Wizard

Preparing for Head Replacement

This step can take up to 30 min.

00: 05

©OBJET

(K] >

Figure 6-59: Printer preparation progress screen

Put on the safety gloves.
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8. When the following screen is displayed, open the printer cover.
Note: The printer disconnects power to the heads for your safety.

Head Optimization Wizard
Print Head Replacement

The printer is ready foryou to replace print heads.
Click 'Next' to continue.

©OBJET

(K]

Figure 6-60: Replace the defective head when this screen appears
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Removing the 9. On the print block, release the upper and lower screws that secure the
Defective Head print head in the block. (If necessary, you may use a screwdriver to
loosen the screws.)

Figure 6-61: Releasing the locking screws

10. Press down on the upper and lower locking screws to release the print
head.

Figure 6-62: Releasing the print head

11. Loosen the screws on the door of the compartment protecting the
print-head driver cards (A), then pull and lift up the door (B).

Figure 6-63: Opening the print-head compartment
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12. Pull the print-head driver card out of its socket so that the head is free
(A), and remove it from the bottom of the print block (B).

Figure 6-64: Releasing the print-head driver card to remove the head

13. Make sure that along with the head, you remove the two rubber O-ring
seals.

Figure 6-65: O-ring seals on the print head

Important: If the seals are not removed with the head, they are probably
stuck to the print block housing. If so, remove them.

|

Figure 6-66: Making sure the O-rings are not stuck to the print block
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Installing the
New Head
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Important: Remove the protective tape from the surface of the
new print head.

14. Inspect the replacement head, and make sure that the O-ring seals are
in place (see figure 6-65).

15. Gently insert the replacement head into the vacant slot in the print
block, and push the print-head driver card into its socket.
Note: Make sure to insert the head with the driver card facing its socket, in
the rear of the print block.

Figure 6-67: Inserting the print-head driver card into its socket

16. Push the head up until you hear it click into place, in both front and
rear holders.

Figure 6-68: Clicking the head into place in the print block
17. Lower the door of the print head compartment, and tighten the screws
to lock it in place.

18. Tighten the upper and lower screws that secure the print head in the
print block (see figure 6-61 on page 43).

Note: Hand-tighten these screws. Do not use a screwdriver.

19. In the Replace print heads screen, select the check box to confirm that
you have replaced the head(s), and click Next.
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20. With your fingers, make sure that the new head is level and even with
the other heads.

Figure 6-69: Checking the level of the new head

21. Confirm that the heads are level and even by selecting the check box in
the following wizard screen, and click Next.

Head Optimization Wizard

Installation Check
Check thatthe print heads are level and even.
\l [ Done
nnngnnnn
(@51
’ XK Cancel ] ’{Erevious] T

Figure 6-70: Installation-check screen

22. In the next wizard screen, select the check box to confirm that you have
removed all tools and objects from the printer.

Head Optimization Wizard

Ay Y. Inspect the build tray

Confirm before continuing:

[ Tray is clear and the cover is clozed.

-
—

2

’ XK Cancel ] ’{Erevious] T

Figure 6-71: Cleared-tray confirmation screen
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23. Close the printer cover.

The wizard continues by filling the heads, then heating and purging them.
If there are no installation problems, the Head Optimization procedure
begins (see “Calibrating Print Heads” on page 6-34).

If a vacuum leakage is detected, or if there are other problems, the wizard

alerts you and instructs you how to continue (see “Installation Problems,”
next).

After replacing print heads, you should check the head alignment before
using the printer to produce models. In the final wizard screen...

® select Yes and click Done to open the Head Alignment Wizard (see
“Aligning the Print Heads” on page 30).

® select No and click Done to align the heads at another time.

Head Optimization Wizard

L. Print-head Optimization

' Completed

Heﬁ Do you want to run the 'Head Alignment' wizard
Alignment Dokl

©OBJET

%

Figure 6-72: Final Head Optimization Wizard Screen
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Installation If the printer detects that there is a problem after you install print heads,
Problems relevant warning screens appear.

® [f the printer software does not sense the replaced head, the following
warning screen appears.

Head Optimization Wizard

Head Installation Failure

Remaove and re-insert the driver cannector(s)

OBJET

M XK Cancel ‘ =L Fre ‘

Figure 6-73: Incorrect-installation screen

If this happens:
a. Open the print head compartment (see figure 6-63 on page 43).

b. Re-insert the print-head driver card into its socket (see figure 6-67
on page 45).

c. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.

® If the replacement head was not factory-calibrated, the following
warning screen appears.

Head Optimization Wizard

S Head Installation Failure
The installed head does not contain valid data. Try
| | replacing it with another head. Ifthis does not
succeed, contact Customer Support.

[ Aternate print head installed.

©OBJET

? Hep

Figure 6-74: Invalid-data warning screen

If this happens:
a. Remove the head and replace it with another one (starting with step
9 on page 6-43).

b. In the wizard screen, select the check box to confirm that you have
installed another print head, and click Next.

c. Contact your authorized Customer Support center about the
unformatted head.
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e If the vacuum test is not successful, the replacement head was not
sealed properly during installation, and the following warning screen
appears.

Head Optimization Wizard

Head Installation Failure

| Avacuum leakage was detected. The next steps will guide
wau through the procedure for re-installing the head({s).

(ki

©BJET

M XK Cancel ‘ =L Fre ‘

Figure 6-75: Vacuum-leakage warning screen

If this happens:
a. Click Next.

b. Follow the instructions on the wizard screens to re-install the head.

Calibrating the Load cells are sensors that measure the weight of the printing cartridges

Load Cells and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells once a month, with the Load Cell Calibration
Wizard.

To calibrate load cells:

1. Start the Load Cell Calibration Wizard from the Options menu (see
figure 6-25 on page 23).

2. Select one or more load cells that you want to calibrate, and click Next.

Load Cell Calibration Wizard

Choose Calibration Mode

[~ Calibrate Madel weight
[~ Calibrate Suppart weight
[~ Calibrate ' aste weight

©OBJET

? Help XK Cancel | | |

Figure 6-76: Load cell selection

Note: Itis recommended that you routinely calibrate all of the load cells.
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3. Remove the cartridge or container, as instructed by the wizard,
confirm this in the wizard screen, and click Next.

Load Cell Calibration Wizard R|

Remove Right Model Cartridge
from its housing

? Help x Lancel | { Previous | Mext = |

Figure 6-77: Confirmation of cartridge removal

4. Inthe next wizard screen, observe the numbers and wait until the level
is relatively stable—two units above or below the average level shown.

x
Model Weight Status
44D
Current Level 753

[~ Weight is stable

©OBJET

? Help |

Figure 6-78: Load cell calibration screen

5. Select the Weight is stable check box, and click Next.

If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 4 and 5 until all of the load cells are

=Z Brevious | Mest 3= |

calibrated.
6. Click Done in the final wizard screen.
x
Wizard Completed
©OBJET
? Help | 2@ Lancel | ‘% Ereviousl J [one I

Figure 6-79: Final wizard screen
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Replacing the
Odor Filter

Replacing the
UV Lamps

N
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If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (about once a year, as necessary) to keep
your working environment pleasant. This is normally done during the
yearly preventive-maintenance service visit.

The UV lamps used for curing models have a long, but limited, working
life. The service engineer tests their effectiveness during regular
maintenance checks, and replaces them, if necessary. If, for any reason, you
need to replace a UV lamp, follow these instructions:

Note: The printer application includes a wizard for user-calibration of UV
lamps. When this user guide was prepared, the UV Calibration
Wizard was not fully tested with an approved UV radiation sensor.
For this reason, you should not use the wizard at this time.

1. Make sure the printer is in offline mode.

Figure 6-80: Offline mode indicator (red)

The online/offline button at the bottom of the printer interface should be
red. If not, click it to switch the printer to offline mode.

WARNING: Before continuing, make sure that the safety interlock in the
printer cover is not defeated, and that the lamp is not hot.

2. Start the UV Lamp Replacement Wizard.

® From the Options menu of the printer interface (see figure 6-25 on
page 23), select Wizards > UV Lamp Replacement.

3. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

U¥Y Lamp Replacement Wizard

UV Lamp Replacement Wizard

Flease werify that the tray is empty

Tray iz empty

Figure 6-81: “Empty tray” confirmation screen

The axes move to the “home” position.

6-51



Operating & Maintaining the Eden260V 3-D Printer

4. Select the UV lamp(s) to be replaced and click Next.

UY Lamp Replacement Wizard

Select the UV lamp you wish to
replace:

" Right L% lamp

" Left UV lamp

i Both UV lamps
(@51

? Help x Lancel | <E

Figure 6-82: UV lamp selection screen

5. Disconnect the power connection to the UV lamp.

Figure 6-83: Disconnecting the UV lamp
Note: Do not disconnect the power connection to the cooling fans.

6. Loosen the screw securing the UV lamp cover (A), and pull the cover
up (B), then out (C).

Figure 6-84: Removing the UV lamp cover
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7. Pull the lamp reflector out of the print block.

Figure 6-85: Removing the UV lamp reflector

Inspect the new lamp reflector, and make sure that a black strip is
attached to the inside of it. If not, install one—on the side of the
reflector opposite (not next to) the print block.

Note: Extra black strips are included in the printer Start-up Kit. If
necessary, you can remove the black strip from the old reflector and install
it in the new reflector (as long as the black paint has not faded).

Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety
requirements.

10. Insert the new UV lamp/reflector unit into the housing next to the print

block.
UV lamp UV lamp
assembly— L 1l = - st  assembly

Black strip4‘ /—Black strip

Figure 6-86: Print block and UV lamp assembly, showing correct placement of
black strip
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11. Replace the lamp cover by inserting it into the slot on the bottom of the
housing, and tighten the securing screw on top.

Figure 6-87: Replacing the lamp cover

12. Reconnect the power connection to the UV lamp.

Figure 6-88: Connecting power to the UV lamp

13. In the wizard screen, confirm that you have replaced the lamp(s) and
that the black strip is attached, then click Next.

U¥Y Lamp Replacement Wizard le

UV Lamp Replacement Wizard

[v U lamp replaced

[v Shadow bracket located corectly [zee help}

? Help x Lancel | ‘% | ﬂext) |

Figure 6-89: UV-installation confirmation screen
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The wizard operates the lamps and checks if their power is within the
acceptable range for each printing mode. (The mode currently being
checked appears in the lower-left corner of the printer interface.)

UY Lamp Replacement Wizard f'5_<|

UV Lamp Replacement Wizard
Y lamps warming (Approx. 4 min)

00: 04

©OBJET

XK Cancel | =Z |

Figure 6-90: Status screen during UV lamp check

14. When the final wizard screen appears, click Done.

U¥Y Lamp Replacement Wizard

UV Replacement Wizard
Completed

©OBJET

Figure 6-91: Final wizard screen
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Built-in Tests

6-56

The software that runs the printer contains a suite of tests for regularly
checking the hardware and software, and for troubleshooting. You can
configure basic communications and environment tests to run
automatically, when the Eden software opens. In addition, you can run a
more comprehensive set of tests before processing a print job, as a system
check, to ensure optimum printing results.

Because running the tests effects the operation of the printer, you can only
open the Built-in Tests interface when the system is not printing.

The test suite features:

® The organization of printing-related tasks in categories:
Communications

Data cards

Temperatures

Voltages

Encoder repeatability

Qo odaaq

Print-head heating
O Print-head filling

® A clear display of test results and the source of any failures, enabling
you to determine if printing is possible or worthwhile.

® The ability to monitor test results for specific components.

® Troubleshooting tips.

Running these tests can help identify problems in the printer hardware and
software. A large number of hardware defects (or near-defects) warns you
of possible printing problems, either for current or future jobs.

Stratasys recommends running the built-in tests in the following cases:

® as aroutine test, once every two weeks

® as a system check, before major (long) jobs

® as needed, for troubleshooting
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Accessing To open the Built-in Tests screen, do one of the following:

Built-in Tests

Test Interface

DOC-32011 Rev. A

® From the Options menu, select Built-In Tests.
® DPress Ctrl+Alt+B.

ns Help

Go ko Tray Upper Position FS
@ Go ko Purge Position F&

Wipe F7?

Purge Sequence F4
Pattern Test F3

‘Wizards
Built Ini T o Crl+Alt+E

Maintenance Counters...
Collect Service Data

Figure 6-92: Selecting Built-In Tests from the Options menu

The Built In Tests screen lists pre-configured tests, grouped by component
categories. In this screen, you select and run tests, and the results are
displayed.

Built In Tests

Test Mame Group Status  Enor Description

O Sub-System Communications Comrunicat... ?

O FIFO Mondntermupt Test Drata Card ?

O FIFD Intermupt Test [ata Card ?

[ Encoder Steps Count Encoder ?

O 5ystem Info Enviranment ?

O Black Filing Filling ?

O Interock. General ?

[ Catin Temperature General ?

[ Head EEFROMs Head Cards 2

O HeadVokages Head Cards ? Surnrmary
[ Head/Block Heaters Heaters ? 2
[ Axes Limits Makors ? B
O Paramemeter 5 arity Check Parameters ?

[ acuum Test W acuum ?

< | &

Tests Selection —

Group Selection Set

’ Al ] l Maone l ’Unknown] |--N0ne - v| |--N0ne - v| -

Figure 6-93:Built In Tests screen
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Test List Test Name
This column lists all of the tests, together with selection check boxes.

Click the check boxes to select the tests you want to run. To remove a
selection, click the check box again. To quickly select all of the tests in a
component category, use the Group pull-down menu at the bottom of the
screen.

Group
This column shows the component categories for each test.

This tells you which tests are run when selecting a category from the Group
pull-down menu at the bottom of the screen.

Status

This column shows the status of each test after you run it:

o  Test successfully completed.

X  Test failed. (Double-click on a failed test’s line to review the failure
details.)
?

Unknown results. (The test has not been run yet.)

Test Selection Area  In the Test Selection area, at the bottom of the screen, you can quickly select
or de-select tests by their characteristics:

All Click to select all of the tests in the list.

None Click to de-select all of the tests in the list.

Unknown Click to select all test that have not been run yet (Status = ?).

Group Use this menu to select tests by component category.
Selection Use this menu to select a pre-configured set of tests to run at
Set specified times (computer startup, before printing, etc.).

Running Tests  To run the selected tests:

After you run a test, the Save and View command buttons are added to the
Built In Tests screen (see below).

Test Results To save and view a report of all of the tests:

» Use the Save and View command buttons (see below).
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Command Buttons  You click the command buttons, on the right side of the screen, to perform

Ln.l Save

S Wiew

Summary

X

‘,E', Help
9% Cloz=

Summary

DOC-32011 Rev. A

the following operations:

Run

Click to run the selected tests.

Reset

Click to clear previously run tests. This returns the status of each test to
Unknown (?).

Save

Click to save a report that summarizes the tests run. The report is saved as
an HTML file. You can save any number of reports for the tests you run; the
name of the file saved is BITReport [date][time].htm. By default, these files

are saved in the Eden installation folder, but you can save it in any other
folder.

View

Click to display the latest test report that you saved. (You can view other
test reports by opening the relevant files in your Web browser. To do so,
open Windows Explorer, and double click the BITReport file.)

Close
Click to close the Built-in Tests screen.

On the right side of the screen, a symbol represents the combined results of
all the tests run, using the symbols from the Status column.

o  All tests successfully completed.
X  Atleast one test failed.

?  Not all tests performed.
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Test Descriptions  The following table lists the name of each test in the Built-in Tests suite,

and

together with its description and a possible reason for its failure. If you

Troubleshooting need assistance, contact your Stratasys service provider.

Test Name Description Possible Reason for Failure
Sub-System Tests communications between Disconnected communications cable.
Communication Eden components. Faulty cable.

FIFO Non-Interrupt/
FIFO Interrupt

Tests the data queue in the DATA
PCI card.

Faulty DATA_PCI card.

Encoder

Tests the encoder's reliability by
comparing readings from multiple
runs along the X-axis.

Faulty encoder.

System Info

Compares the following parameter
values with the minimum
requirements.

® Physical memory
® Available memory
® Free space on disk

® Monitor resolution

Failure of RAM memory allocation in
the Eden computer.

Block Filling

Analyzes the thermistor readings
when the block is full and when it is
empty.

Faulty thermistor.

Interlock

Tests the interlock in the printer
cover.

Failure of interlock mechanism.
Faulty latch.
Disconnected cables.

Cabin Temperature

Tests the temperature level in the
build-tray area.

Faulty temperature sensor (OHDB).

Head EEPROM Tests the read/write capabilities of | Faulty print-head driver card.
the print-head driver cards.

Head Voltage Checks the control of voltages Faulty print-head driver card.
supplied to the print heads.

Tray Heater Not used for this printer —

Head/Block Heaters | Tests the heaters in the print heads | Faulty heaters or thermistors.
and in the print-block body.

Axes Limit Tests the hardware and software Faulty hardware sensors.

limits of all axes.

Wrong Max Position parameter.

Parameter Sanity
Check

Compares the values of all printer
parameters (in cfg files) to the
required values.

One or more of the printer parameters
is not within the required range. You
can view details in the BIT report.

Vacuum Tests the vacuum level in the print | Faulty vacuum sensor.
block. Vacuum leakage.
Wrong parameters.
DOC-32011 Rev. A
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Replacing the = The waste container contains partially cured polymeric material produced

Waste during normal operation and maintenance of the printer. For safety and

Container environmental reasons, this material is kept in a special leak-proof,
disposable container.

The container has a capacity of about eight kilograms of waste material —
usually enough for several months of printer use. The printer software
displays a warning message when there is 7.3 kilograms of material in the
container, and stops the printing when the net weight reaches 7.8
kilograms. Above 7.3 kilograms, the software does not allow you to start a
print job (or a printing activity) until you replace the waste container. You
can monitor the weight of the waste container in the Maintenance screen of
the printer interface.

To monitor the waste weight (and other indicators) in the printer:

> In the main printer interface screen, click the display toggle to view the
printer indicators.

O5Jan20%0 183

Haads {"C)
T
[ 24 J 35 | 35§l 35 B
T

Alacsa (ary e
Waste weight ENRAIRH O BT Heads Liguid
Arnbiant (*C) B Heocsveoum

o000
27
UV Lamps L .l Pri Heater = Display
toggle button

EDSN 260V

Curertfdods Dulaufdncds

Figure 6-94: Printer interface, showing waste weight (red background indicates
operator alert)

The waste container consists of a sealed bag inside a cardboard box. You
typically dispose of the entire waste container —including the box.
Therefore, you must assemble a new box and insert a new waste bag before
you can install it in the printer.

Replacement boxes, waste bags, and sealing caps are supplied in the Eden
printer start-up kit and in the preventive-maintenance Kkit.
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To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Fold a new waste bag—so it fits in the box —and insert the bag’s screw-
connector into the hole in the top of the box.

Note: Do not close the box until you connect the waste drain tube from the
printer (see below).

To replace the waste container:

1. Push the door of the lower printer compartment to open it.

Waste container

Figure 6-95: Waste container under the printer

2. Carefully slide out the waste container to remove it from the printer.

Figure 6-96: Waste container removed from the printer

3. Place the new waste container next to the full container.

4. Unscrew the cap securing the waste drain tube and connect it to the
new container.
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Cleaning the
Exterior Panels
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5.

6.
7.

8.

Close the full container with a sealing cap.

Note: The sealing cap contains an inner stopper that prevents leakage
when the cap is tightened. Do not be concerned that air can still flow
through the opening on the top of the cap, since the inner stopper seals the
waste container.

Stopper Opening in top

Figure 6-97: Waste container sealing cap
Close the new waste-container box.

Position the waste container under the printer, on the load cells.

Note: Make sure that the waste drain tube is not crimped and that it is not
pinched by the container.

Close the compartment door.

Dispose of the full waste container in accordance with environmental and
safety requirements.

The painted exterior plastic panels of Eden 3-D printers have a durable
finish, offering excellent chemical resistance to common cleaning agents.
However, follow the recommendations below when cleaning these areas of
the printer.

Acceptable Cleaning Agents

mild soap solution
common household cleaners and window cleaners
common commercial and industrial detergents, 5% solution in water

alcohol (ethanol, isopropanol), 10% to 40% solution in water

Wipe the exterior of the printer, using a soft cloth moistened with the
cleaning solution.

Unacceptable Materials

industrial solvents

cleaning agents containing hydrocarbons, ketones, esters and lacquer
thinners

spray disinfectants

abrasives and agents which could wear away the panel finish
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Handling Printed Models

Removing Models After Printing

N

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the printer, it is best to let the printed models cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional models as soon as
possible:
1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or
spatula (supplied in the tool kit), taking care not to pry or bend the
model.

WARNING: Wear protective gloves when handling printed models
before they are washed.

3. Place the models on a flat surface, and cover them with a cardboard
box or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support Material with Water Pressure

For most models, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Objet Water]Jet
cleaning unit, shown in figure 7-1 on page 7-3.
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Figure 7-1: Objet WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump
turns ordinary tap water into a high-pressure jet, and a wiper keeps the
window clear.

Use caution when cleaning delicate models with high-pressure water
systems.

Removing Support Material with Caustic Soda

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half-an-hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly
(with a water jet) afterwards.

WARNING: Caustic soda may cause chemical burns, scarring and
blindness. Mixing it with water generates heat that could ignite other
materials.Take adequate safety precautions; always use nitrile gloves
when handling caustic soda and models soaked in it.

Models are cured as they are printed, making them safe and stable for a
long time. However, proper storage conditions are necessary to prevent
deforming.

® Keep printed models at room temperature and in a low-humidity
environment.

® Do not expose models to direct sunlight and other heat sources.
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